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This document describes the following software options:

● R&S®AMU-K40/-K41/-K240/-K241
1402.6106.02, 1403.0253.02, 1402.7602.02, 1403.0201.02

● R&S®SMATE-K40/-K41
1404.5107.02, 1404.8306.02

● R&S®SMBV-K40/-K41/-K240/-K241
1415.8031.xx, 1415.8460.xx, 1415.8213.xx, 1415.8454.xx

● R&S®SMJ-K40/-K41/-K240/-K241
1404.0305.02, 1409.2706.02, 1409.0510.02, 1409.2758.02

● R&S®SMU-K40/-K41/-K240/-K241
1160.7609.02, 1408.7810.02, 1408.5518.02, 1408.7862.02

● R&S®AFQ-K240/-K241
1401.6302.02, 1401.6102.02

● R&S®CMW-KW200
1203.0951.02

● R&S®SFU-K240/-K241
2115.2237.02, 2115.2243.02
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Muehldorfstr. 15, 81671 Munich, Germany
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R&S® is a registered trademark of Rohde & Schwarz GmbH & Co. KG.
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The following abbreviations are used throughout this manual: R&S®AMU is abbreviated as R&S AMU, R&S®SMATE is abbreviated as
R&S SMATE, R&S®SMBV is abbreviated as R&S SMBV, R&S®SMJ is abbreviated as R&S SMJ, R&S®SMU is abbreviated as
R&S SMU, R&S®WinIQSIM2 is abbreviated as R&S WinIQSIM2
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Basic Safety Instructions 
Always read through and comply with the following safety instructions! 

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety 
standards of our products up to date and to offer our customers the highest possible degree of safety. Our 
products and the auxiliary equipment they require are designed, built and tested in accordance with the 
safety standards that apply in each case. Compliance with these standards is continuously monitored by 
our quality assurance system. The product described here has been designed, built and tested in 
accordance with the attached EC Certificate of Conformity and has left the manufacturer’s plant in a 
condition fully complying with safety standards. To maintain this condition and to ensure safe operation, 
you must observe all instructions and warnings provided in this manual. If you have any questions 
regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer 
them. 

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed 
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must 
not be used in any way that may cause personal injury or property damage. You are responsible if the 
product is used for any intention other than its designated purpose or in disregard of the manufacturer's 
instructions. The manufacturer shall assume no responsibility for such use of the product.  

The product is used for its designated purpose if it is used in accordance with its product documentation 
and within its performance limits (see data sheet, documentation, the following safety instructions). Using 
the product requires technical skills and a basic knowledge of English. It is therefore essential that only 
skilled and specialized staff or thoroughly trained personnel with the required skills be allowed to use the 
product. If personal safety gear is required for using Rohde & Schwarz products, this will be indicated at 
the appropriate place in the product documentation. Keep the basic safety instructions and the product 
documentation in a safe place and pass them on to the subsequent users. 

Observing the safety instructions will help prevent personal injury or damage of any kind caused by 
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions 
before and when using the product. It is also absolutely essential to observe the additional safety 
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In 
these safety instructions, the word "product" refers to all merchandise sold and distributed by the Rohde & 
Schwarz group of companies, including instruments, systems and all accessories.  

Symbols and safety labels 

Notice, general 
danger location 

Observe product 
documentation 

Caution 
when 
handling 
heavy 
equipment 

Danger of 
electric 
shock 

Warning! 
Hot surface 

PE terminal Ground Ground 
terminal 

Be careful when 
handling 
electrostatic 
sensitive 
devices 

ON/OFF supply 
voltage  

Standby 
indication  

Direct current 
(DC) 

Alternating current 
(AC) 

Direct/alternating 
current (DC/AC) 

Device fully protected by 
double (reinforced) insulation 
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Tags and their meaning 

The following signal words are used in the product documentation in order to warn the reader about risks 
and dangers. 

indicates a hazardous situation which, if not avoided, will result in death or 
serious injury. 

indicates a hazardous situation which, if not avoided, could result in death or 
serious injury. 

indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury. 

indicates the possibility of incorrect operation which can result in damage to 
the product.  
In the product documentation, the word ATTENTION is used synonymously.  

 
These tags are in accordance with the standard definition for civil applications in the European Economic 
Area. Definitions that deviate from the standard definition may also exist in other economic areas or 
military applications. It is therefore essential to make sure that the tags described here are always used 
only in connection with the related product documentation and the related product. The use of tags in 
connection with unrelated products or documentation can result in misinterpretation and in personal injury 
or material damage. 

Operating states and operating positions 

The product may be operated only under the operating conditions and in the positions specified by the 
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are 
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local 
or national safety regulations and rules for the prevention of accidents must be observed in all work 
performed.  

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:  
predefined operating position is always with the housing floor facing down, IP protection 2X, pollution 
severity 2, overvoltage category 2, use only indoors, max. operating altitude 2000 m above sea level, 
max. transport altitude 4500 m above sea level. A tolerance of ±10 % shall apply to the nominal 
voltage and ±5 % to the nominal frequency. 

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability 
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when 
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation 
that is not carried out as described in the product documentation could result in personal injury or 
death. 

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient 
temperature must not exceed the maximum temperature specified in the product documentation or in 
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or 
death. 
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Electrical safety 

If the information on electrical safety is not observed either at all to the extent necessary, electric shock, 
fire and/or serious personal injury or death may occur.  

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product 
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power 
fuse of the product may have to be changed accordingly.  

2. In the case of products of safety class I with movable power cord and connector, operation is 
permitted only on sockets with an earthing contact and protective earth connection. 

3. Intentionally breaking the protective earth connection either in the feed line or in the product itself is 
not permitted. Doing so can result in the danger of an electric shock from the product. If extension 
cords or connector strips are implemented, they must be checked on a regular basis to ensure that 
they are safe to use. 

4. If the product does not have a power switch for disconnection from the AC supply network, the plug of 
the connecting cable is regarded as the disconnecting device. In such cases, always ensure that the 
power plug is easily reachable and accessible at all times (corresponding to the length of connecting 
cable, approx. 2 m). Functional or electronic switches are not suitable for providing disconnection from 
the AC supply network. If products without power switches are integrated into racks or systems, a 
disconnecting device must be provided at the system level. 

5. Never use the product if the power cable is damaged. Check the power cable on a regular basis to 
ensure that it is in proper operating condition. By taking appropriate safety measures and carefully 
laying the power cable, you can ensure that the cable will not be damaged and that no one can be 
hurt by, for example, tripping over the cable or suffering an electric shock.  

6. The product may be operated only from TN/TT supply networks fused with max. 16 A (higher fuse 
only after consulting with the Rohde & Schwarz group of companies). 

7. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the 
socket. Otherwise, sparks that result in fire and/or injuries may occur.  

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric 
shocks. 

9. For measurements in circuits with voltages Vrms > 30 V, suitable measures (e.g. appropriate 
measuring equipment, fusing, current limiting, electrical separation, insulation) should be taken to 
avoid any hazards. 

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial 
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply 
in each case. 

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in 
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the 
product. 

12. If a product is to be permanently installed, the connection between the PE terminal on site and the 
product's PE conductor must be made first before any other connection is made. The product may be 
installed and connected only by a licensed electrician. 

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective 
devices, the supply circuit must be fused in such a way that anyone who has access to the product, as 
well as the product itself, is adequately protected from injury or damage. 
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14. Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of 
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the 
danger of an electric shock. 

15. Any object that is not designed to be placed in the openings of the housing must not be used for this 
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries. 

16. Unless specified otherwise, products are not liquid-proof (see also section "Operating states and 
operating positions", item 1. Therefore, the equipment must be protected against penetration by 
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product 
itself may be damaged, which can also lead to personal injury. 

17. Never use the product under conditions in which condensation has formed or can form in or on the 
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water 
increases the risk of electric shock. 

18. Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network 
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such 
as alcohol, acetone or diluents for cellulose lacquers. 

Operation 

1. Operating the products requires special training and intense concentration. Make sure that persons 
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries 
or material damage may occur. It is the responsibility of the employer/operator to select suitable 
personnel for operating the products. 

2. Before you move or transport the product, read and observe the section titled "Transport". 

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction 
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a 
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz 
product, consult a physician immediately to determine the cause and to prevent health problems or 
stress.  

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be 
sure to read and pay special attention to the section titled "Waste disposal", item 1. 

5. Depending on the function, certain products such as RF radio equipment can produce an elevated 
level of electromagnetic radiation. Considering that unborn babies require increased protection, 
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be 
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces 
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the 
potential danger. 

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can 
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and 
protective clothing must be worn. 

7. If a laser product (e.g. a CD/DVD drive) is integrated into a Rohde & Schwarz product, absolutely no 
other settings or functions may be used as described in the product documentation. The objective is to 
prevent personal injury (e.g. due to laser beams). 
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Repair and service 

1. The product may be opened only by authorized, specially trained personnel. Before any work is 
performed on the product or before the product is opened, it must be disconnected from the AC supply 
network. Otherwise, personnel will be exposed to the risk of an electric shock.  

2. Adjustments, replacement of parts, maintenance and repair may be performed only by electrical 
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant 
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed 
after parts relevant to safety have been replaced (visual inspection, PE conductor test, insulation 
resistance measurement, leakage current measurement, functional test). This helps ensure the 
continued safety of the product.  

Batteries and rechargeable batteries/cells 

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the 
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal 
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g. 
lithium cells) must be handled in accordance with the EN 62133 standard. 

1. Cells must not be taken apart or crushed.  

2. Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided. 
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth. 

3. Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a 
drawer where they can short-circuit each other, or where they can be short-circuited by other 
conductive materials. Cells and batteries must not be removed from their original packaging until they 
are ready to be used. 

4. Keep cells and batteries out of the hands of children. If a cell or a battery has been swallowed, seek 
medical aid immediately. 

5. Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted. 

6. If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If 
contact occurs, wash the affected area with plenty of water and seek medical aid. 

7. Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells) 
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see 
parts list) in order to ensure the safety of the product.  

8. Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries 
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the 
national regulations regarding waste disposal and recycling.  

Transport 

1. The product may be very heavy. Therefore, the product must be handled with care. In some cases, 
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid 
back or other physical injuries.  
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2. Handles on the products are designed exclusively to enable personnel to transport the product. It is 
therefore not permissible to use handles to fasten the product to or on transport equipment such as 
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the 
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of 
transport or lifting. Noncompliance can result in personal injury or material damage. 

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely 
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the 
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the 
product in the vehicle to prevent injuries or other damage in the event of an accident.  

Waste disposal 

1. If products or their components are mechanically and/or thermally processed in a manner that goes 
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel) 
may be released. For this reason, the product may only be disassembled by specially trained 
personnel. Improper disassembly may be hazardous to your health. National waste disposal 
regulations must be observed.  

2. If handling the product releases hazardous substances or fuels that must be disposed of in a special 
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the 
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal 
regulations must be observed. Also observe the relevant safety instructions in the product 
documentation. The improper disposal of hazardous substances or fuels can cause health problems 
and lead to environmental damage. 

Informaciones elementales de seguridad 
Es imprescindible leer y observar las siguientes instrucciones e informaciones de seguridad! 

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al día 
con los estándares de seguridad y de ofrecer a nuestros clientes el máximo grado de seguridad. Nuestros 
productos y todos los equipos adicionales son siempre fabricados y examinados según las normas de 
seguridad vigentes. Nuestro sistema de garantía de calidad controla constantemente que sean cumplidas 
estas normas. El presente producto ha sido fabricado y examinado según el certificado de conformidad 
adjunto de la UE y ha salido de nuestra planta en estado impecable según los estándares técnicos de 
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario 
deberá atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de 
empresas Rohde & Schwarz está siempre a su disposición en caso de que tengan preguntas referentes a 
estas informaciones de seguridad. 

Además queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto 
está destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente 
autorizado, para aplicaciones de campo y de ninguna manera deberá ser utilizado de modo que alguna 
persona/cosa pueda sufrir daño. El uso del producto fuera de sus fines definidos o sin tener en cuenta las 
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna 
forma responsable de consecuencias a causa del mal uso del producto.  
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Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las 
indicaciones de la correspondiente documentación del producto y dentro del margen de rendimiento 
definido (ver hoja de datos, documentación, informaciones de seguridad que siguen). El uso del producto 
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener 
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en 
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el 
uso de productos de Rohde & Schwarz, encontraría la información debida en la documentación del 
producto en el capítulo correspondiente. Guarde bien las informaciones de seguridad elementales, así 
como la documentación del producto, y entréguelas a usuarios posteriores. 

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o daños por 
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las 
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del 
producto. Deberán tenerse en cuenta todas las demás informaciones de seguridad, como p. ej. las 
referentes a la protección de personas, que encontrarán en el capítulo correspondiente de la 
documentación del producto y que también son de obligado cumplimiento. En las presentes 
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas 
Rohde & Schwarz bajo la denominación de "producto", entre ellos también aparatos, instalaciones así 
como toda clase de accesorios. 

Símbolos y definiciones de seguridad 

Aviso: punto de 
peligro general 

Observar la 
documentación 
del producto 

Atención en 
el manejo de 
dispositivos 
de peso 
elevado 

Peligro de 
choque 
eléctrico 

Adver-
tencia: 
superficie 
caliente 

Conexión a 
conductor de 
protección 

Conexión 
a tierra 

Conexión 
a masa 

Aviso: Cuidado 
en el manejo de 
dispositivos 
sensibles a la 
electrostática 
(ESD) 

Tensión de 
alimentación de 
PUESTA EN 
MARCHA / 
PARADA  

Indicación de 
estado de 
espera  
(Standby)  

Corriente 
continua (DC) 

Corriente alterna 
(AC) 

Corriente 
continua / 
Corriente alterna 
(DC/AC) 

El aparato está protegido 
en su totalidad por un 
aislamiento doble 
(reforzado) 
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Palabras de señal y su significado 

En la documentación del producto se utilizan las siguientes palabras de señal con el fin de advertir contra 
riesgos y peligros. 

PELIGRO identifica un peligro inminente con riesgo elevado que 
provocará muerte o lesiones graves si no se evita.  

ADVERTENCIA identifica un posible peligro con riesgo medio de 
provocar muerte o lesiones (graves) si no se evita. 

ATENCIÓN identifica un peligro con riesgo reducido de provocar 
lesiones leves o moderadas si no se evita. 

AVISO indica la posibilidad de utilizar mal el producto y, como 
consecuencia, dañarlo. 
En la documentación del producto se emplea de forma sinónima el 
término CUIDADO. 

 
Las palabras de señal corresponden a la definición habitual para aplicaciones civiles en el área 
económica europea. Pueden existir definiciones diferentes a esta definición en otras áreas económicas o 
en aplicaciones militares. Por eso se deberá tener en cuenta que las palabras de señal aquí descritas 
sean utilizadas siempre solamente en combinación con la correspondiente documentación del producto y 
solamente en combinación con el producto correspondiente. La utilización de las palabras de señal en 
combinación con productos o documentaciones que no les correspondan puede llevar a interpretaciones 
equivocadas y tener por consecuencia daños en personas u objetos. 

Estados operativos y posiciones de funcionamiento 

El producto solamente debe ser utilizado según lo indicado por el fabricante respecto a los estados 
operativos y posiciones de funcionamiento sin que se obstruya la ventilación. Si no se siguen las 
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con 
posible consecuencia de muerte. En todos los trabajos deberán ser tenidas en cuenta las normas 
nacionales y locales de seguridad del trabajo y de prevención de accidentes.  

1. Si no se convino de otra manera, es para los productos Rohde & Schwarz válido lo que sigue:  
como posición de funcionamiento se define por principio la posición con el suelo de la caja para 
abajo, modo de protección IP 2X, grado de suciedad 2, categoría de sobrecarga eléctrica 2, uso 
solamente en estancias interiores, utilización hasta 2000 m sobre el nivel del mar, transporte hasta 
4500 m sobre el nivel del mar. Se aplicará una tolerancia de ±10 % sobre el voltaje nominal y de 
±5 % sobre la frecuencia nominal. 

2. No sitúe el producto encima de superficies, vehículos, estantes o mesas, que por sus características 
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalación del 
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si 
se realiza la instalación de modo distinto al indicado en la documentación del producto, pueden 
causarse lesiones o incluso la muerte. 

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La 
temperatura ambiente no debe superar la temperatura máxima especificada en la documentación del 
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse 
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte. 
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Seguridad eléctrica 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad 
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia 
de muerte.  

1. Antes de la puesta en marcha del producto se deberá comprobar siempre que la tensión 
preseleccionada en el producto coincida con la de la red de alimentación eléctrica. Si es necesario 
modificar el ajuste de tensión, también se deberán cambiar en caso dado los fusibles 
correspondientes del producto.  

2. Los productos de la clase de protección I con alimentación móvil y enchufe individual solamente 
podrán enchufarse a tomas de corriente con contacto de seguridad y con conductor de protección 
conectado. 

3. Queda prohibida la interrupción intencionada del conductor de protección, tanto en la toma de 
corriente como en el mismo producto. La interrupción puede tener como consecuencia el riesgo de 
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de 
enchufe, deberá garantizarse la realización de un examen regular de los mismos en cuanto a su 
estado técnico de seguridad. 

4. Si el producto no está equipado con un interruptor para desconectarlo de la red, se deberá considerar 
el enchufe del cable de conexión como interruptor. En estos casos se deberá asegurar que el enchufe 
siempre sea de fácil acceso (de acuerdo con la longitud del cable de conexión, aproximadamente 
2 m). Los interruptores de función o electrónicos no son aptos para el corte de la red eléctrica. Si los 
productos sin interruptor están integrados en bastidores o instalaciones, se deberá colocar el 
interruptor en el nivel de la instalación. 

5. No utilice nunca el producto si está dañado el cable de conexión a red. Compruebe regularmente el 
correcto estado de los cables de conexión a red. Asegúrese, mediante las medidas de protección y 
de instalación adecuadas, de que el cable de conexión a red no pueda ser dañado o de que nadie 
pueda ser dañado por él, p. ej. al tropezar o por un choque eléctrico.  

6. Solamente está permitido el funcionamiento en redes de alimentación TN/TT aseguradas con fusibles 
de 16 A como máximo (utilización de fusibles de mayor amperaje solo previa consulta con el grupo de 
empresas Rohde & Schwarz). 

7. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por 
completo y fuertemente en la toma de corriente. La no observación de estas medidas puede provocar 
chispas, fuego y/o lesiones. 

8. No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto 
podría causar fuego o choques eléctricos. 

9. En las mediciones en circuitos de corriente con una tensión Ueff > 30 V se deberán tomar las medidas 
apropiadas para impedir cualquier peligro (p. ej. medios de medición adecuados, seguros, limitación 
de tensión, corte protector, aislamiento etc.). 

10. Para la conexión con dispositivos informáticos como un PC o un ordenador industrial, debe 
comprobarse que éstos cumplan los estándares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1 
válidos en cada caso. 

11. A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa 
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y 
puede causar lesiones, fuego o daños en el producto. 
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12. Si un producto se instala en un lugar fijo, se deberá primero conectar el conductor de protección fijo 
con el conductor de protección del producto antes de hacer cualquier otra conexión. La instalación y 
la conexión deberán ser efectuadas por un electricista especializado. 

13. En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automático ni otros 
mecanismos de seguridad similares, el circuito de alimentación debe estar protegido de modo que 
todas las personas que puedan acceder al producto, así como el producto mismo, estén a salvo de 
posibles daños. 

14. Todo producto debe estar protegido contra sobretensión (debida p. ej. a una caída del rayo) mediante 
los correspondientes sistemas de protección. Si no, el personal que lo utilice quedará expuesto al 
peligro de choque eléctrico. 

15. No debe introducirse en los orificios de la caja del aparato ningún objeto que no esté destinado a ello. 
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o 
lesiones. 

16. Salvo indicación contraria, los productos no están impermeabilizados (ver también el capítulo 
"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las 
medidas necesarias para evitar la entrada de líquidos. En caso contrario, existe peligro de choque 
eléctrico para el usuario o de daños en el producto, que también pueden redundar en peligro para las 
personas. 

17. No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido 
condensaciones sobre el producto o en el interior de éste, como p. ej. al desplazarlo de un lugar frío a 
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico. 

18. Antes de la limpieza, desconecte por completo el producto de la alimentación de tensión (p. ej. red de 
alimentación o batería). Realice la limpieza de los aparatos con un paño suave, que no se deshilache. 
No utilice bajo ningún concepto productos de limpieza químicos como alcohol, acetona o diluyentes 
para lacas nitrocelulósicas. 

Funcionamiento 

1. El uso del producto requiere instrucciones especiales y una alta concentración durante el manejo. 
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos 
necesarios en cuanto a aptitudes físicas, psíquicas y emocionales, ya que de otra manera no se 
pueden excluir lesiones o daños de objetos. El empresario u operador es responsable de seleccionar 
el personal usuario apto para el manejo del producto. 

2. Antes de desplazar o transportar el producto, lea y tenga en cuenta el capítulo "Transporte". 

3. Como con todo producto de fabricación industrial no puede quedar excluida en general la posibilidad 
de que se produzcan alergias provocadas por algunos materiales empleados, los llamados alérgenos 
(p. ej. el níquel). Si durante el manejo de productos Rohde & Schwarz se producen reacciones 
alérgicas, como p. ej. irritaciones cutáneas, estornudos continuos, enrojecimiento de la conjuntiva o 
dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las causas y 
evitar cualquier molestia o daño a la salud.  

4. Antes de la manipulación mecánica y/o térmica o el desmontaje del producto, debe tenerse en cuenta 
imprescindiblemente el capítulo "Eliminación", punto 1. 
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5. Ciertos productos, como p. ej. las instalaciones de radiocomunicación RF, pueden a causa de su 
función natural, emitir una radiación electromagnética aumentada. Deben tomarse todas las medidas 
necesarias para la protección de las mujeres embarazadas. También las personas con marcapasos 
pueden correr peligro a causa de la radiación electromagnética. El empresario/operador tiene la 
obligación de evaluar y señalizar las áreas de trabajo en las que exista un riesgo elevado de 
exposición a radiaciones. 

6. Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias tóxicas 
(gases, líquidos etc.) que pueden generar daños a la salud. Por eso, en caso de incendio deben 
usarse medidas adecuadas, como p. ej. máscaras antigás e indumentaria de protección. 

7. En caso de que un producto Rohde & Schwarz contenga un producto láser (p. ej. un lector de 
CD/DVD), no debe usarse ninguna otra configuración o función aparte de las descritas en la 
documentación del producto, a fin de evitar lesiones (p. ej. debidas a irradiación láser). 

Reparación y mantenimiento 

1. El producto solamente debe ser abierto por personal especializado con autorización para ello. Antes 
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensión de alimentación, para 
evitar toda posibilidad de choque eléctrico.  

2. El ajuste, el cambio de partes, el mantenimiento y la reparación deberán ser efectuadas solamente 
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los 
aspectos de seguridad (p. ej. el enchufe, los transformadores o los fusibles), solamente podrán ser 
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad 
deberá realizarse un control de seguridad (control a primera vista, control del conductor de 
protección, medición de resistencia de aislamiento, medición de la corriente de fuga, control de 
funcionamiento). Con esto queda garantizada la seguridad del producto.  

Baterías y acumuladores o celdas 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterías y 
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible 
consecuencia de muerte. El manejo de baterías y acumuladores con electrolitos alcalinos (p. ej. celdas de 
litio) debe seguir el estándar EN 62133. 

1. No deben desmontarse, abrirse ni triturarse las celdas.  

2. Las celdas o baterías no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz 
directa del sol. Las celdas y baterías deben mantenerse limpias y secas. Limpiar las conexiones 
sucias con un paño seco y limpio. 

3. Las celdas o baterías no deben cortocircuitarse. Es peligroso almacenar las celdas o baterías en 
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto recíproco o por contacto con 
otros materiales conductores. No deben extraerse las celdas o baterías de sus embalajes originales 
hasta el momento en que vayan a utilizarse. 

4. Mantener baterías y celdas fuera del alcance de los niños. En caso de ingestión de una celda o 
batería, avisar inmediatamente a un médico. 

5. Las celdas o baterías no deben someterse a impactos mecánicos fuertes indebidos. 
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6. En caso de falta de estanqueidad de una celda, el líquido vertido no debe entrar en contacto con la 
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un 
médico. 

7. En caso de cambio o recarga inadecuados, las celdas o baterías que contienen electrolitos alcalinos 
(p. ej. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o 
baterías solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de 
recambios).  

8. Las baterías y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterías o 
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales. 
Respete en esta relación las normas nacionales de eliminación y reciclaje.  

Transporte 

1. El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con 
precaución y, si es necesario, usando un sistema de elevación adecuado (p. ej. una carretilla 
elevadora), a fin de evitar lesiones en la espalda u otros daños personales.  

2. Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por 
personas. Por eso no está permitido utilizar las asas para la sujeción en o sobre medios de transporte 
como p. ej. grúas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los 
productos de manera segura a los medios de transporte o elevación. Para evitar daños personales o 
daños en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o 
elevación utilizado. 

3. Si se utiliza el producto dentro de un vehículo, recae de manera exclusiva en el conductor la 
responsabilidad de conducir el vehículo de manera segura y adecuada. El fabricante no asumirá 
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un 
vehículo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehículo 
debidamente para evitar, en caso de un accidente, lesiones u otra clase de daños.  

Eliminación 

1. Si se trabaja de manera mecánica y/o térmica cualquier producto o componente más allá del 
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales 
pesados como p. ej. plomo, berilio o níquel). Por eso el producto solo debe ser desmontado por 
personal especializado con formación adecuada. Un desmontaje inadecuado puede ocasionar daños 
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminación de 
residuos. 

2. En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que 
deban tratarse como residuos especiales (p. ej. refrigerantes o aceites de motor con intervalos de 
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas 
sustancias y las normas regionales de eliminación de residuos. Tenga en cuenta también en caso 
necesario las indicaciones de seguridad especiales contenidas en la documentación del producto. La 
eliminación incorrecta de sustancias peligrosas o combustibles puede causar daños a la salud o 
daños al medio ambiente. 



Sehr geehrter Kunde,
Sie haben sich für den Kauf eines  
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Customer Support 
 

Technical support – where and when you need it 
For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support 
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a 
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz 
equipment. 
 

Up-to-date information and upgrades 
To keep your instrument up-to-date and to be informed about new application notes related to your 
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish. 
We will take care that you will get the right information. 
 

Europe, Africa, Middle East Phone +49 89 4129 12345 
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988 
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com

mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport@rohde-schwarz.com
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1 Preface

1.1 Documentation Overview

The user documentation for the R&S Signal Generator consists of the following parts:

● Online Help system on the instrument,
● "Quick Start Guide" printed manual,
● Documentation CD-ROM with:

– Online help system (*.chm) as a standalone help,
– Operating Manuals for base unit and options,
– Service Manual,
– Data sheet and specifications,
– Links to useful sites on the R&S internet.

Online Help

The Online Help is embedded in the instrument's firmware. It offers quick, context-sen-
sitive access to the complete information needed for operation and programming. The
online help contains help on operating the R&S Signal Generator and all available
options.

Quick Start Guide

The Quick Start Guide is delivered with the instrument in printed form and in PDF format
on the Documentation CD-ROM. It provides the information needed to set up and start
working with the instrument. Basic operations and an example of setup are described.
The manual includes also general information, e.g., Safety Instructions.

Operating Manuals

The Operating Manuals are a supplement to the Quick Start Guide. Operating Manuals
are provided for the base unit and each additional (software) option.

These manuals are available in PDF format - in printable form - on the Documentation
CD-ROM delivered with the instrument. In the Operating Manual for the base unit, all
instrument functions are described in detail. Furthermore, it provides an introduction to
remote control and a complete description of the remote control commands with pro-
gramming examples. Information on maintenance, instrument interfaces and error mes-
sages is also given.

In the individual option manuals, the specific instrument functions of the option are
described in detail. For additional information on default settings and parameters, refer
to the data sheets. Basic information on operating the R&S Signal Generator is not inclu-
ded in the option manuals.

These manuals can also be orderd in printed form (see ordering information in the data
sheet).

 

 

Documentation Overview
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Service Manual

The Service Manual is available in PDF format - in printable form - on the Documentation
CD-ROM delivered with the instrument. It describes how to check compliance with rated
specifications, on instrument function, repair, troubleshooting and fault elimination. It
contains all information required for repairing the instrument by the replacement of mod-
ules.

This manual can also be orderd in printed form (see ordering information in the data
sheet).

Release Notes

The release notes describe new and modified functions, eliminated problems, and last
minute changes to the documentation. The corresponding firmware version is indicated
on the title page of the release notes. The current release notes are provided in the
Internet.

1.2 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface elements" All names of graphical user interface elements on the
screen, such as dialog boxes, menus, options, but-
tons, and softkeys are enclosed by quotation marks.

KEYS Key names are written in capital letters.

File names, commands, program code File names, commands, coding samples and screen
output are distinguished by their font.

Input Input to be entered by the user is displayed in italics.

​Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are
enclosed by quotation marks.

 

Typographical Conventions
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2 Introduction
The R&S Signal Generator equipped with option R&S SMx/AMU-K40 enables you to
generate signals in accordance with the GSM/EDGE standard, based on the GMSK and
8PSK modulation. Option R&S SMx/AMU-K41 EDGE Evolution extends the GSM/EDGE
signal generation with simulation of higher order modulations (QPSK, 16QAM and
32QAM) for higher symbol rate bursts and higher order modulations (16QAM and
32QAM) for normal symbol rate bursts.

GSM is a TDMA standard for cellular mobile radio networks and is used worldwide. The
R&S Signal Generator is suitable as a signal generator for all GSM variants. There is no
restriction regarding the use of GSM slots, EDGE slots and EDGE Evolution slots.

The R&S Signal Generator can generate both the transmitter signal of a base station (BS)
and the transmitter signal of user equipment (UE).

Every TDMA frame consists of 8 timeslots (or simply "slots"). Each slot can be separately
turned on or off. A maximum of 7 different level attenuation values can be defined and
allocated separately to the 8 slots quite independently of one another.

In order to configure a slot it is necessary to define a burst type. Different burst types are
available, depending on the installed options on the instrument.

For instruments equipped only with option R&S SMx/AMU-K40, you can choose between
data bursts Normal (full rate and half rate) and EDGE; control bursts Access, Frequency
Correction and Synchronization; a Dummy Burst; and bursts for test purposes, All_Data
(GSM and EDGE). Not only can you generate half rate slots but you can also define
multislots for HSCSD (high speed circuit switched data) and (E)GPRS (general packet
radio service) configurations at the physical level, if necessary allocating multiple slots to
a single connection (channel banding).

The option R&S SMx/AMU-K41 extends the available burst types with burst types defined
for normal symbol rate and higher order modulation schemes such as the data burst
Normal (16QAM and 32QAM) and All_Data (16QAM and 32QAM) as well as with the
burst types defined for higher symbol rates HSR (QPSK, 16QAM and 32QAM) and HSR
All_Data (QPSK, 16QAM and 32QAM).

Higher symbol rates are achieved by reduction of the symbol period and employing of
higher symbol rate bursts (HB) instead of the normal burst (NB). A normal burst contains
116 encrypted symbols and uses time slots with normal duration (156 or 157 symbols
long). The higher symbol rate bursts carry information on full rate packet traffic channels,
contain 138 encrypted symbols and use time slots with reduced symbol duration (187 or
188 symbols long).

The option R&S SMx/AMU-K41 provides additionally the functionality to configure and
generate burst for VAMOS operation. All_Data (AQPSK) and Normal (AQPSK) bursts for
full and half rate operation are available.

The modulation data is continuously inserted into the chosen slots (in realtime). In this
fashion the data generator uses a digital signal processor to generate a data stream
complete with modulation data and control signals for power ramping.

This data stream is converted into I/Q signals in the modulation encoder.
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The signal is processed depending on the configured modulation scheme and selected
symbol rate mode:
● In accordance with the GSM standard, the MSK modulation type is set by default to

a symbol rate of 270.833ksymb/s and Gauss filtering. The symbol rate can be
changed in the R&S Signal Generator. FSK with adjustable span can also be used
as the modulation type.

● In accordance with the standard, in the case of EDGE slots the 8PSK modulation
type is set by default to 3/8( rotation at a symbol rate of 270.833ksymb/s and Gauss
linearized filtering.

● In accordance to EDGE Evolution specifications (option R&S SMx/AMU-K41), the
EDGE Evolution slots in a normal burst (NB) are 16QAM or 32QAM modulated at a
symbol rate of 270.833ksymb/s and Gauss linearized filtering. The EDGE Evolution
slots in a higher symbol rate bursts (HB) are QPSK, 16QAM or 32QAM modulated at
a symbol rate of 325ksymb/s and spectrally Narrow or Wide Pulse Shape filtering.

● In accordance to VAMOS specifications (option R&S SMx/AMU-K41), the slots are
AQPSK modulated at a symbol rate of 270.833ksymb/s and Gauss linearized filtering.

Three modes for each the normal and the higher symbol rate mode are available for
configuring a GSM/EDGE signal:
● Mode Unframed - a signal with standard-compliant modulation parameters but with-

out slot and frame structure is generated.
● Mode Frame (Single) - a signal consisting of a frame is generated; it is also possible

to choose half rate bursts and to define multislots.
● Mode Frame (Double) - a signal consisting of two frames is generated; the frames

are repeated according to a defined default.

2.1 VAMOS (Voice services over Adaptive Multi-user chan-
nels on One Slot)

According to 3GPP TS 45.001, with VAMOS it is possible to serve two MS simultaneously
on the same physical resource. Thus the voice channel capacity in the CS domain can
be doubled.

Each of the two VAMOS users is assigned a so-called VAMOS subchannel, i.e. the
physical radio resource is split into two subchannels, one for each VAMOS user. The two
subchannels are separated in uplink and downlink via training sequences. For this pur-
pose 3GPP TS 45.002 defines two sets of Training Sequence Codes (TSC). One VAMOS
user/subchannel gets a training sequence from TSC set 1, the other from TSC set 2. This
ensures that the two training sequences have a very low cross-correlation. All mobiles
must support TSC set 1, but only mobiles explicitly indicating support for VAMOS must
also support TSC set 2.

In the uplink two GMSK modulated signals interfere with each other and the base station
receiver requires an advanced multi-user detection algoritm.

In the downlink a novel modulation scheme is used for each subchannel. The two sub-
channels are combined orthogonally by mapping them to the I and Q axis. This results

 

VAMOS (Voice services over Adaptive Multi-user channels on One Slot)



IntroductionGSM/EDGE

9Operating Manual 1171.5254.12 ─ 12

in a QPSK modulation scheme, where each constellation point has a subchannel 1 com-
ponent and a subchannel 2 component, as shown in the following figure.

Fig. 2-1: QPSK modulation, sum of both subchannels

In this figure both subchannels use the same power level. VAMOS allows subchannel-
specific power control, so that the two subchannels can use different power levels, e.g.
when the two users are located at different distances from the base station. The resulting
modulation scheme is called Adaptive QPSK (AQPSK). The following figure shows an
example where subchannel 2 mapped to the Q-axis uses a higher power level than sub-
channel 1 mapped to the I-axis.

Fig. 2-2: AQPSK modulation, subchannel 2 with higher power level

VAMOS (Voice services over Adaptive Multi-user channels on One Slot)
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The power level of subchannel 2 relative to the power level of subchannel 1 is called
Subchannel Power Imbalance Ratio (SCPIR). It is related to the angle α as follows:

SCPIR = 20 * log10(tan α) dB,

where the value of α shall be chosen such that |SCPIR|≤10dB

For α = 45° the SCPIR equals 0 dB and the two power levels are equal.

AQPSK modulation is applied in the downlink if speech frames have to be transmitted on
both subchannels simultaneously.

The R&S Signal Generator allows to set the SCPIR and configure the VAMOS subchan-
nels, TSC set and TSC used. The available VAMOS settings depend on the mode the
signal is generated in:
● "Unframed"

Two data sources are provided, one per each VAMOS subchannel; the data is
AQPSK modulated but only one SCPIR can be configured.

● "Framed (Single)"
Full Rate, Half Rate and combination of both slot types are supported. The charac-
teristics of each of the half rate slots can be adjusted individually
Separate data source is provided per each VAMOS subchannel and each user in half
rate mode; the data is AQPSK modulated and eigth SCPIRs can be configured
Training Sequence (TSC) set and TSC used can be configured on a VAMOS sub-
channel/User basis

● "Framed (Double)"
The settings of each of the two frames are as in the "Framed (Single)" mode.

VAMOS (Voice services over Adaptive Multi-user channels on One Slot)
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3 GSM/EDGE User Interface
To access the dialog for setting the digital standard, select "Baseband block > GSM/
EDGE" or use the menu tree under "Baseband".

3.1 GSM/EDGE Main Menu

The menu offered different differs according to the mode selected. Most of the submenus
and settings are available to all modes, however.

The upper part of the menu is used for turning on the GSM/EDGE digital standard and
choosing the mode.

The "Set to Default" button calls the default settings for the GSM/EDGE standard.

The submenus for choosing the modulation, for setting the trigger and clock parameters
and for data list management are available to all modes.

For all modes except Unframed, the submenus for saving and loading a frame and for
setting the power ramping and slot attenuation are also available.

The lower part of the menu displays the chosen frame configuration, except in Unframed
mode when it displays the signal configuration.

In this graphical display you can select the slot that you wish to edit. The burst editor then
opens.

 

 

GSM/EDGE Main Menu
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State
Switches the GSM/EDGE standard on/off.

Enabling this standard disables all the other digital standards and digital modulation
modes (in case of two-path instruments, this affects the same path).

GSM/EDGE is a realtime system (no precalculated signal), and therefore all parameter
changes (in the ON state) directly affect the output signal.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​STATe ​ on page 66

Set to Default
Calls default settings. The values are shown in the following table.

Parameter Value

State Not affected by Set to Default

Mode Framed (single)

Modulation  

Symbol Rate Mode Normal Symbol Rate

Symbol Rate 270.833 ksymb/s

Ignore 1/4... Off

Force Dummy Bits to 1 Off

Mod. Type GSM MSK 1bit/sym

Filter Gauss

Filter Par. BT 0.3

Power Ramp Control  

Ramp Time 2 sym

Function Cosine

Slot Attenuation 1...7 0 dB

Slot 0 Configuration  

Burst Type Normal (full rate)

Slot Level Full

Multislot Off

Number of Slots 1

GSM/EDGE Main Menu
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Parameter Value

Data PRBS 9

Use Stealing Flag On

Stealing Flag 0

TSC Set 1, TSC 0

Slot 1-7 Configuration  

Slot Level,

other settings as slot 0

Off

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​PRESet ​ on page 63

Save/Recall
Calls the "Save/Recall" menu.

From the "Save/Recall" menu, the "File Select" windows for saving and recalling GSM
configurations and the "File Manager" can be called.

"Recall GSM
setting"

Opens the "File Select" window for loading a saved GSM configuration.
The configuration of the selected (highlighted) file is loaded by pressing
the "Select" button.

"Save GSM
setting"

Opens the "File Select" window for saving the current GSM signal con-
figuration.
The name of the file is specified in the "File name" entry field, the direc-
tory selected in the "save into" field. The file is saved by pressing the
"Save" button.
The "Fast Save" checkbox determines whether the instrument performs
an absolute or a differential storing of the settings. Enable this function
to accelerate the saving process by saving only the settings with values
different to the default ones. "Fast Save" is not affected by the "Pre-
set" function.

"File Manage" Calls the "File Manager".
The "File Manager" is used to copy, delete and rename files and to
create new directories.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SETTing: ​CATalog ​ on page 64
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SETTing: ​LOAD ​ on page 64
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SETTing: ​STORe ​ on page 65
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SETTing: ​STORe: ​FAST ​ on page 65
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SETTing: ​DELete ​ on page 64

Data List Management
Calls the "Data List Management" menu. This menu is used to select and edit a data list.

GSM/EDGE Main Menu
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All data lists are stored as files with the predefined file extension *.dm_iqd. The file
name and the directory they are stored in are user-definable.

The data lists must be selected as a data source in the Burst Editor.

Note: All data lists are generated and edited by means of the SOURce:BB:DM subsystem
commands. Files containing data lists end with *.dm_iqd. The data lists are selected
as a data source for a specific function in the individual subsystems of the digital standard.

Example: Creating and editing the data list
SOUR:BB:DM:DLIS:SEL "gsm"
SOUR:BB:DM:DLIS:DATA 1,1,0,1,0,1,0,1,1,1,1,0,0,0
SOUR:BB:DM:DLIS:DATA:APP  1,1,0,1,0,1,0,1,1,1,1,0,0,0

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA ​ on page 100
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA: ​DLISt ​ on page 100

Generate Waveform File…
Calls the "Generate Waveform" menu. This menu is used to store the current GSM/EDGE
signal as ARB signal in a waveform file.

This file can be loaded in the "ARB" dialog and processed as multi carrier or multi segment
signal.

The file name is entered in the submenu. The file is stored with the predefined file exten-
sion *.wv. The file name and the directory it is stored in are user-definable.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​WAVeform: ​CREate ​ on page 67

Sequence Mode
Selects GSM/EDGE mode.

There are three modes available:
● Unframed

see ​chapter 3.2, "Mode Unframed", on page 16
● Framed (single)

see ​chapter 3.3, "Mode Framed (single)", on page 18
● Framed (double)

see ​chapter 3.4, "Mode Framed (double)", on page 19

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​MODE ​ on page 62

GSM/EDGE Main Menu
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Symbol Rate Mode
(for instruments equipped with option K41 only)

Set the symbol rate mode, i.e. determines whether a normal bursts (NB) or higher symbol
rate bursts (HB) will be generated.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SRATe: ​MODE ​ on page 66

Sequence Length
(For R&S WinIQSIM2 only)

Selects the sequence length of the arbitrary waveform file in the number of frames or
symbols.

For unframed "GSM Mode", the sequence length is set in number of symbols and in
number of frames for framed GSM mode respectively.

In case the "GSM Mode" is set to double framed, the sequence length of the generated
ARB file is determined by the parameter "Frame Repetition" for both frames:

Sequence Length = Frame Repetition of Frame 1 + Frame Repetition of Frame 2.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SLENgth ​ on page 61
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FLENgth ​ on page 60

Modulation/Filter
Calls the "Modulation/Filter" menu. The Modulation menu is used for setting the modu-
lation and filter parameters, see ​chapter 3.6, "Modulation/Filter", on page 23.

SCPI command: 
n.a.

Power Ramping/Slot Attenuations
Calls the "Power Ramping/Slot Attenuation" menu. This menu is used to set the power
ramping parameters and for setting values for the level attenuation in dB, see ​chapter 3.7,
"Power Ramping/Slot Attenuation", on page 29.

The currently selected ramp function and ramp time are displayed.

SCPI command: 
n.a.

Trigger/Marker
Calls the "Trigger/Marker/Clock" menu.

This menu is used to select the trigger source, configure the marker output signals and
set the time delay on an external trigger signal, see ​chapter 3.8, "Trigger/Marker/Clock
Settings", on page 32.

SCPI command: 
n.a.

GSM/EDGE Main Menu
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Execute Trigger
Executes trigger manually. A manual trigger can be executed only when an internal trig-
ger source and a trigger mode other than "Auto" have been selected.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​EXECute ​ on page 84

Clock
Calls the "Trigger/Marker/Clock" menu. This menu is used to select the clock source, see
​chapter 3.8.4, "Clock Settings", on page 40.

SCPI command: 
n.a.

3.2 Mode Unframed

In "Unframed" mode a modulation signal without slot or frame structure is generated. The
modulated carrier without power ramping is often enough for initial tests, and in case the
complete signal is not yet needed.

Since all the modulation parameters for the signal are conform to the standard, only the
symbol rate mode (normal or higher symbol rate) and the modulation (MSK or FSK for
GSM, 8PSK EDGE for EDGE and 16QAM EDGE or 32QAM EDGE for EDGE Evolution)
have to be selected. The symbol rate and filter configuration are set accordingly.

This mode can be used for quick measurements of the spectrum or signal quality (e.g.
EVM).

The submenus for selecting the modulation (see ​chapter 3.6, "Modulation/Fil-
ter", on page 23), as well as the trigger, marker and clock (see ​chapter 3.8, "Trigger/
Marker/Clock Settings", on page 32) are offered.

 

Mode Unframed
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Simulation Mode
Selects the modulation for the signal.

The signal is generated without slot or frame structure.

The available simulation modes depend on the selected symbol rate:
● Normal Symbol Rate - GSM (MSK or FSK), AQPSK, 8PSK/EDGE, 16QAM and

32QAM
● Higher Symbol Rate - HSR QPSK, HSR 16QAM and HSR 32QAM.
For GSM, the modulation to be used (MSK or FSK) is set by means of the parameter
"Modulation" in the "Modulation/Filter" menu.

Note: "Higher Symbol Rate Mode" and "Simulation Modes" AQPSK, 16QAM, 32QAM,
HSR QPSK, HSR 16QAM and HSR 32QAM are available for instruments equipped with
option R&S SMx/AMU-K41 only.
The graphical display shows the signal in Unframed mode - no frames, no power ramping.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SMODe ​ on page 65

Mode Unframed
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Data
Selects data source.

You may choose from the following data sources:

"All 0, All 1" 0 data or 1 data is internally generated.

"Pattern" A user-definable bit pattern with a maximum length of 32 bits is inter-
nally generated.
The bit pattern is defined in the "Pattern" input box.

"PRBS xx" PRBS data in accordance with the IUT-T with period lengths between
29-1 and 223-1 are internally generated.

"Data List" Internal data from a programmable data list created with the aid of the
data editor is used.
Data lists are selected from the Select List submenu.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA ​ on page 100
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA: ​PATTern ​ on page 101
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA: ​DLISt ​ on page 100

3.3 Mode Framed (single)

The "Framed (single)" mode generates a modulation signal which is defined by the struc-
ture of a single frame. The frame structure is repeated cyclically, but the useful data is
continuously generated.

The frame structure is displayed in graphical form. Slot parameters can be defined in the
burst editor, which is called when the slot is selected in the graphical display (see ​chap-
ter 3.9, "Burst Editor", on page 42). You can define half rate slots. The characteristics
of each half rate slot can be defined separately. Each active slot is represented by a burst
symbol. Two half rate slots occupy the space of a full rate slot. A slot in which the level
has been attenuated is represented by a lower amplitude burst. Inactive slots (Slot Level
= Off) are shown as a horizontal bar. If multislots have been defined, the banded slots
are surrounded by a frame (slots 5 to 7 in the illustration).

When a half rate slot has been selected, two frames are generated alternately. Each
frame holds one of the two half rate users.

 

Mode Framed (single)
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Example: 
The following configuration is set, from a frame with two slots that contain half rate users:

As a result, the following two frames are generated alternately:
● Frame with half rate user 1:

● Frame with half rate user 2

The following submenus are offered:
● For saving and loading a frame structure (see ​chapter 3.5, "Save Recall Frame/

Slots", on page 21).
● For selecting the modulation (see ​chapter 3.6, "Modulation/Filter", on page 23).
● For selecting the trigger, marker and clock (see ​chapter 3.8, "Trigger/Marker/Clock

Settings", on page 32).
● For power ramping and defining the attenuation (see ​chapter 3.7, "Power Ramping/

Slot Attenuation", on page 29).

Save/Recall Frame …
Call the "Save/Recall Frame" dialog for selecting of predefined or user defined frames.

The menu is described in ​chapter 3.5, "Save Recall Frame/Slots", on page 21.

SCPI command: 
n.a.

3.4 Mode Framed (double)

The "Framed (double)" mode generates multiframe signals which are defined by the
structure of two frames.

 

Mode Framed (double)
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For this purpose two frames are defined as in "Framed (single)" mode. A repetition factor
is then specified for each of the two frames. Following a trigger the first frame is repeated
the specified number of times, and then the second frame. The frame structures are
repeated cyclically, but the useful data is continuously generated.

If one of the frames contains half rate slots (and so actually consists of 2 frames itself),
the repetition factor must be a multiple of 2 (see ​chapter 3.3, "Mode Framed (sin-
gle)", on page 18).

The frame structure of the two frames is displayed in graphical form. Slot parameters can
be defined in the burst editor, which is called when the slot is selected in the graphical
display (see ​chapter 3.9, "Burst Editor", on page 42).

The following dialogs are offered:
● For saving and loading a frame structure (see ​chapter 3.5, "Save Recall Frame/

Slots", on page 21).
● For selecting the modulation (see ​chapter 3.6, "Modulation/Filter", on page 23).
● For selecting the trigger, marker and clock (see ​chapter 3.8, "Trigger/Marker/Clock

Settings", on page 32).
● For power ramping and defining the attenuation (see ​chapter 3.7, "Power Ramping/

Slot Attenuation", on page 29).

Save/Recall Frame …
Call the "Save/Recall Frame" dialog for selecting of predefined or user defined frames.

The menu is described in ​chapter 3.5, "Save Recall Frame/Slots", on page 21.

SCPI command: 
n.a.

Mode Framed (double)
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Frame Repetition
Enters the number of repetitions for frame 1 or frame 2. First frame 1 is repeated the
specified number of times, and then frame 2, then frame 1 starts again, and so on.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FRAMe<di>: ​REPetitions ​ on page 62

3.5 Save Recall Frame/Slots

The "Save/Recall Frame" dialog is accessed via the "GSM/EDGE" main dialog.

The "Save/Recall Slots" dialog is accessed via the "Burst Editor" dialog.

When you call the submenu using the corresponding button a box opens from which you
can select the function you require:

The "File Select" menus save and load (i.e. recall) user-defined frames or slots. Prede-
fined frames or slots can also be recalled. Each menu offer access to the "File Man-
ager" for general file management.

Predefined Frames and Slots are stored on a predefined path. This path is automatically
set in the "File Select" window.

In the Normal Symbol Rate mode, user-defined Frames and Slots are stored as files with
the specific file extensions *.gsm_fu or *.gsm_slu, respectively.

In the Higher Symbol Rate mode, user-defined Frames and Slots are stored as files with
the specific file extensions *.gsm_hfu or *.gsm_hslu, respectively. Independent of
the selected symbol rate mode, the files with user-defined Frames and Slots can be
stored in a user-determined directory and called from there.

It is not possible to use other file extensions. Attempting to do so will cause an error
message. If the file extension is modified (e.g. by directly accessing the file system) the
files are no longer recognized and therefore invalid.

In the following examples of commands the files are stored in the default directory which
is defined by command MMEM:CDIRectory.

Recall Predefined Frame/Slot
Calls the File Select menu for loading a predefined frame/slot.

 

Save Recall Frame/Slots



GSM/EDGE User InterfaceGSM/EDGE

22Operating Manual 1171.5254.12 ─ 12

"EDGE0" Predefined frame
slot 0 = On, full level, EDGE burst, all other slots off.

"EDGEAll" Predefined frame
all slots On, full level, EDGE burst

"GsmEdge" Predefined frame
alternately one slot with NORMAL burst and EDGE burst

"Normal-
Burst0"

Predefined frame
slot 0 = On, full level, NORMAL burst (full rate), all other slots off

"NormalBur-
stAll"

Predefined frame
all slots On, full level, NORMAL burst (full rate)

"GSM_NB_PN
9_TSC0"

Predefined slot
NORMAL burst (full rate), full level, attenuation A1, multislot = Off,
number of multislots = 1, Data = PRBS 9, Use Stealing Flag = On,
TSC0, all slot-marker set to "all down".

"GSM_NB_PN
9_TSC0"

Predefined slot
EDGE burst (full rate), full level, attenuation A1, multislot = Off, number
of multislots = 1, Data = PRBS 9, Use Stealing Flag = On, TSC0, all
slot-marker set to "all down"

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​PREDefined: ​CATalog ​ on page 69
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​PREDefined: ​LOAD ​ on page 69
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​PREDefined: ​CATalog ​ on page 70
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​PREDefined: ​LOAD ​ on page 70

Recall User Frame/Slot
Calls the "File Select" menu for loading a user-defined frame/slot.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FRAMe<di>: ​ULISt: ​CATalog ​ on page 68
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FRAMe<di>: ​ULISt: ​LOAD ​ on page 68
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ULISt: ​CATalog ​ on page 70
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ULISt: ​LOAD ​ on page 71

Save Recall Frame/Slots
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Save User Frame/Slot
Calls the File Select menu for saving the current frame or slot settings.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FRAMe<di>: ​ULISt: ​STORe ​ on page 69
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ULISt: ​STORe ​ on page 71

File Manager
Calls the "File Manager".

The "File Manager" is used to copy, delete and rename files and to create new directories.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FRAMe<di>: ​ULISt: ​DELete ​ on page 68
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ULISt: ​DELete ​ on page 71

3.6 Modulation/Filter

The "Modulation/Filter" menu is accessed via the "GSM/EDGE" main menu.

The parameters displayed depend on the selected "Symbol Rate Mode". The parameters
are grouped in different sections, according to the modulation (MSK/FSK, 8PSK/EDGE,
QPSK, AQPSK, 16QAM or 32QAM) they apply to.

"Higher Symbol Rate Mode", AQPSK modulation and higher order modulations (16QAM
and 32QAM) are available for instruments equipped with option R&S SMx/AMU-K41 only.

 

Modulation/Filter



GSM/EDGE User InterfaceGSM/EDGE

24Operating Manual 1171.5254.12 ─ 12

3.6.1 General Settings

Symbol Rate
Sets the symbol rate. The symbol rate is determined by the selected "Symbol Rate
Mode".

 

Modulation/Filter
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For normal symbol rate mode, the default value for GSM/EDGE is 270.833 33 ksymb/s.

For higher symbol rate mode, the default value for EDGE Evolution is 325 ksymb/s.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SRATe ​ on page 66

Ignore 1/4 symbol (slot length 156 sym) / Ignore 1/2 symbol (slot length 187 sym)
Selects constant slot length. This setting affects all burst types.

In a normal burst (NB), the GSM slot has a length of 156.25 symbols. Compensation for
the 1/4 symbol takes the form of an extra symbol every 4th slot. This means that some
slots are 156 long and some are 157 long. Compensation takes place in the guard field
of the burst (see ​chapter 3.9, "Burst Editor", on page 42).

In a higher symbol rate burst (HB), the average slot is 187.5 symbols long. Compensation
for ½ symbol means that each second slot gets an extra symbol and is 188 symbols long,
while the rest uses a slot length of 187 symbols.

If the field "Ignore 1/4 symbol (slot length 156 symbols) / Ignore 1/2 symbol (slot length
187 symbols)" is enabled, all slots are 156 respectively 187 symbols long. The extra 1/4
resp. 1/2 symbol is omitted. The guard field for the burst always has the same length
regardless of the slot index.

For normal burst, a frame is therefore 1248 symbols long instead of 1250.

Respectively, the length of the frame in a higher symbol rate burst is then 1496 symbols
long instead of 1500 symbols.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​ISLength ​ on page 62

Force Dummy Bits to 1
A modulating bit stream consisting of consecutive ones is used for inactive slots (accord-
ing to GSM 05.04). If this parameter is disabled, the inactive slots are filled in with 0.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FONE ​ on page 61

Oversampling
(For R&S WinIQSIM2 only)

Determines the upsampling factor. If the check box is activated, the most sensible param-
eter values are selected. The value depends on the coherence check. If the check box
is deactivated, the values can be changed manually.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​OSAMpling: ​AUTO ​ on page 77
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​OSAMpling ​ on page 77

3.6.2 MSK/FSK

The settings for MSK/FSK modulation are brought together in the MSK/FSK section.
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Modulation Type GSM
Selects modulation type for GSM signal.

"MSK 1bit/symbol" = Minimum Shift Keying

"FSK 1bit/symbol" = Frequency Shift Keying

The selected modulation is also displayed in graphical form.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FORMat ​ on page 72

FSK Deviation
Sets the deviation when selecting FSK.

When MSK is selected, the deviation is set permanently to symbol_rate/4.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FSK: ​DEViation ​ on page 72

Filter
Displays filter for GSM signal. The filter is permanently set to GAUSS.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​TYPE ​ on page 76

Filter Parameter
Sets the BxT value for the GAUSS filter. The GSM default value is 0.3.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​PARameter ​ on page 76

3.6.3 AQPSK

(with option R&S SMx/AMU-K41 only)

The settings for AQPSK modulation are brought together in the AQPSK section.

Modulation AQPSK
Displays modulation type for GSM signal. The modulation type is set permanently to
AQPSK (see ​chapter 2.1, "VAMOS (Voice services over Adaptive Multi-user channels
on One Slot)", on page 8).

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​AQPSk: ​FORMat ​ on page 73

Angle alpha_0 ... alpha_7
Sets the angle alpha (see ​figure 2-2).

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​AQPSk: ​ANGLe<ch0> ​ on page 75

SCPIR_0 .. SCPIR_7
The power level of subchannel 1 relative to the power level of subchannel 2 is called
Subchannel Power Imbalance Ratio (SCPIR). It is related to the angle α as follows:
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SCPIR = 20 * log10(tan α) dB,

where the value of α shall be chosen such that |SCPIR|≤10dB

For α = 45° the SCPIR equals 0 dB and the two power levels are equal.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​AQPSk: ​SCPIR<ch0> ​ on page 75

Filter
Displays the filter type for AQPSK modulation. The filter is permanently set to GAUSS
linearized.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​AQPSK: ​TYPE ​ on page 77

3.6.4 8 PSK / EDGE

The settings for EDGE modulation are brought together in the EDGE section.

Modulation Type EDGE
Displays modulation type for EDGE signal. The modulation type is set permanently to
8PSK EDGE (3pi/8 8PSK). Unlike the modulation types for GSM the modulation type for
EDGE has 3 bits per symbol.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​EDGE: ​FORMat ​ on page 72

Filter
Displays filter for EDGE signal. The filter is permanently set to GAUSS linearized.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​EDGE: ​TYPE ​ on page 77

3.6.5 16QAM

(for instruments equipped with option R&S SMx/AMU-K41 only)

The settings for 16QAM modulation are brought together in the 16QAM section.

Modulation Type 16QAM
Displays modulation type for signal.

The modulation type 16QAM has 4 bits per symbol.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​N16Qam: ​FORMat ​ on page 74

Filter
Displays filter for 16QAM signal. The filter is permanently set to GAUSS linearized.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​N16Qam: ​TYPE ​ on page 78
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3.6.6 32QAM

(for instruments equipped with option K41 only)

The settings for 32QAM modulation are brought together in the 32QAM section.

Modulation Type 32QAM
Displays modulation type for signal.

The modulation type 32QAM has 5 bits per symbol.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​N32Qam: ​FORMat ​ on page 75

Filter
Displays filter for 32QAM signal. The filter is permanently set to GAUSS linearized.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​N32Qam: ​TYPE ​ on page 78

3.6.7 HSR QPSK

The settings for QPSK modulation are brought together in the HSR QPSK section.

Modulation Type HSR QPSK
(for Higher Symbol Rate only)

Displays modulation type for signal.

The modulation type QPSK EDGE has 2 bits per symbol.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​HQPSk: ​FORMat ​ on page 74

Filter
(for Higher Symbol Rate only)

Displays the filters for HSR QPSK EDGE signal.

The two possible filters are displayed. The currently used filter is set per HSR QPSK slot
with the parameter "Filter".

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​FILTer: ​TYPE ​ on page 99
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​HQPSk: ​TYPE ​ on page 78

3.6.8 HSR 16QAM

The settings for 16QAM modulation are brought together in the HSR 16QAM section.

Modulation Type HSR 16QAM
(for Higher Symbol Rate only)

Displays modulation type for signal.
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The modulation type 16QAM has 4 bits per symbol.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​H16Qam: ​FORMat ​ on page 73

Filter
(for Higher Symbol Rate only)

Displays filter for HSR 16QAM signal.

The two possible filters are displayed. The currently used filter is set per HSR 16QAM
slot with the parameter Filter.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​FILTer: ​TYPE ​ on page 99
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​H32Qam: ​TYPE ​ on page 78

3.6.9 HSR 32QAM

The settings for 32QAM modulation are brought together in the HSR 32QAM section.

Modulation Type HSR 32QAM
(for Higher Symbol Rate only)

Displays modulation type for signal.

The modulation type 32QAM has 5 bits per symbol.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​H32Qam: ​FORMat ​ on page 73

Filter
(for Higher Symbol Rate only)

Displays filter for 32QAM signal.

The two possible filters are displayed. The currently used filter is set per HSR 32QAM
slot with the parameter Filter.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​FILTer: ​TYPE ​ on page 99
​[: ​SOURce<hw>]: ​BB: ​GSM: ​FILTer: ​H32Qam: ​TYPE ​ on page 78

3.7 Power Ramping/Slot Attenuation

The "Power Ramping/Slot Attenuation" menu is accessed via the "GSM/EDGE" main
menu.

This menu is used to enter the settings for power ramping and level attenuation.

The "Power Ramp Control" section is used for setting the power ramp envelope.
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The "Slot Attenuations (Used in Burst Editors)" section is used to define seven possible
values for level attenuation. These values can be selected from the burst editor for the
slot currently being edited. An eight value is permanently set to 0 dB and corresponds to
the "Slot Level Full" setting in the burst editor.

The "Power Ramping/ Level Attenuation" section is used for restricting power ramping to
the baseband signal.

Ramp Time
Enters the power ramping rise time and fall time for a burst. The setting is expressed in
symbols.

The transmitted power must not be switched abruptly at the start and end of a burst,
because the switching operation would otherwise generate excessively strong non-har-
monics; the switching operation is therefore stretched over several symbol clocks.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​PRAMp: ​TIME ​ on page 95

Ramp Function
Enters the form of the transmitted power during the switching operation, i.e. the shape of
the rising and falling edges of the envelope.

"Linear" The transmitted power rises and falls linear fashion.

"Cosine" The transmitted power rises and falls with a cosine-shaped edge. This
gives rise to a more favorable spectrum than the Linear setting.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​PRAMp: ​SHAPe ​ on page 95
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Rise Delay - Power Ramp Control
Sets the offset in the rising edge of the envelope at the start of a burst. A positive value
gives rise to a delay and a negative value causes an advance. The setting is expressed
in symbols.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​PRAMp: ​RDELay ​ on page 95

Fall Delay - Power Ramp Control
Sets the offset in the falling edge of the envelope at the end of a burst. A positive value
gives rise to a delay and a negative value causes an advance. The setting is expressed
in symbols.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​PRAMp: ​FDELay ​ on page 94

Slot Attenuation A1 to A7
Enters seven different values for level attenuation.

The burst editor can be used to set the level attenuation for the 8 slots to one of these
predefined values independently of one another.

The ability to set a sequence of slots purposely to different levels (loud - soft - loud) in
order to measure transmission stability is a requirement of measurement recommenda-
tion 11.21 in the latest GSM version 8.6.09.

The burst editor is likewise used to assign the "Slot Level" attribute "Attenuated" to indi-
vidual slots.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​SATTenuation<ch> ​ on page 63

Baseband Only - Power Ramp Control
(Instruments with RF output only)

Restricts power ramping to the baseband signal.

"Off" Level attenuation is effected via the attenuator stages in the RF section;
only the remaining part is attenuated in the baseband. The signal is
issued at the RF output with the defined level values. This setting pro-
vides the best possible dynamic for bursted signals.

Power Ramping/Slot Attenuation
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"On" Level attenuation is effected in the baseband only.

This setting is mandatory in the following cases:
● When only the baseband signal is issued at the I/Q outputs. It is

thus ensured that, with power ramping active, this signal is output
with the defined level values.

● When a baseband signal is applied to two RF paths of an two-path
instrument. The RF paths having separate frequency and level set-
tings, the remaining attenuation to be effected in the baseband
would have to be different for the two paths and is therefore not
possible.

● When a bursted baseband signal (GSM/EDGE) is combined with a
continuous baseband signal (e.g. 3GPP) or a noise signal and both
signals are applied to one RF path of an two-path instrument.
Blanking in the RF paths is not suitable, because the RF section
would not only blank the bursted signal of the first baseband but
also the continuous signal of the second baseband or the noise
signal.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​PRAMp: ​BBONly[: ​STATe] ​ on page 94

3.8 Trigger/Marker/Clock Settings

The trigger, clock, and marker delay functions are available for R&S SMx and R&S AMU
instruments only.

Additional marker settings are entered at the slot level (see ​chapter 3.9, "Burst Edi-
tor", on page 42). For instance, at that level a data mask signal can be assigned to a
marker connector. Such settings take effect when the marker signal "As defined in
Slots" is selected.

Synchronizing the R&S Signal Generator to an external GSM frame sync signal

When synchronizing the R&S Signal Generator to an external GSM frame sync signal,
the following settings are recommended:
● Trigger Mode = Armed_Auto
● Trigger Source = External Clock
● Clock Source = External
● Clock Mode = Fractional Symbol
● Symbol Clock Divider = 1250

The external GSM frame sync signal must be provided only at the clock input.
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Trigger/Marker/Clock Dialog

To access this dialog, select "Main Menu > Trigger/Marker".

The "Trigger In" section is where the trigger for the signal is set. Various parameters will
be provided for the settings, depending on which trigger source - internal or external - is
selected. The current status of signal generation ("Running" or "Stopped") is indicated
for all trigger modes.

The "Marker Mode" section is where the marker signals at the MARKER output connec-
tors are configured.

The "Marker Delay" section is where a marker signal delay can be defined, either without
restriction or restricted to the dynamic section, i.e., the section in which it is possible to
make settings without restarting signal and marker generation.

The "Clock Settings" section is where the clock source is selected and - in the case of an
external source - the clock type.

The buttons in the last section lead to submenu for general trigger, clock and mapping
settings.

Trigger/Marker/Clock Settings
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3.8.1 Trigger In

The trigger functions are available for R&S SMx and R&S AMU instruments only.

The "Trigger In" section is where the trigger for the signal is set. Various parameters will
be provided for the settings, depending on which trigger source - internal or external - is
selected. The current status of signal generation ("Running" or "Stopped") is indicated
for all trigger modes.

Trigger Mode
Selects trigger mode.

The trigger mode determines the effect of a trigger on the signal generation.

"Auto" The signal is generated continuously.

"Retrigger" The signal is generated continuously. A trigger event (internal or exter-
nal) causes a restart.

"Armed_Auto" The signal is generated only when a trigger event occurs. Then the
signal is generated continuously.
Button "Arm" stops signal generation. A subsequent trigger event (inter-
nal with "Execute Trigger" or external) causes a restart.

"Armed_Ret-
rigger"

The signal is generated only when a trigger event occurs. Then the
signal is generated continuously. Every subsequent trigger event cau-
ses a restart.
Button "Arm" stops signal generation. A subsequent trigger event (inter-
nal with "Execute Trigger" or external) causes a restart.

"Single" The signal is generated only when a trigger event occurs. Then the
signal is generated once to the length specified at "Signal Duration".
Every subsequent trigger event (internal with "Execute Trigger" or
external) causes a restart.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​TRIGger]: ​SEQuence ​ on page 82

Signal Duration Unit
Defines the unit for the entry of the length of the signal sequence to be output in the Single
trigger mode. Available units are symbols or frames.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​SLUNit ​ on page 86

Signal Duration
Defines the length of the signal sequence to be output in the "Single" trigger mode.
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It is possible to output deliberately just part of the signal, an exact sequence of the signal,
or a defined number of repetitions of the signal.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​SLENgth ​ on page 86

Running - Stopped
Displays the status of signal generation for all trigger modes. This display appears only
when signal generation is enabled ("State" On).

"Running" The modulation signal is generated; a trigger was (internally or exter-
nally) initiated in triggered mode.
If "Armed_Auto" and "Armed_Retrigger" have been selected, genera-
tion of signals can be stopped with the "Arm" button. A new trigger
(internally with "Execute Trigger" or externally) causes a restart.

"Stopped" The signal is not generated, and the instrument waits for a trigger event
(internal or external).

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​RMODe ​ on page 85

Arm
Stops signal generation for trigger modes "Armed Auto" and "Armed Retrigger". A sub-
sequent internal or external trigger event restart signal generation.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​ARM: ​EXECute ​ on page 83

Execute Trigger
Executes trigger manually. A manual trigger can be executed only when an internal trig-
ger source and a trigger mode other than "Auto" have been selected.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​EXECute ​ on page 84

Trigger Source
Selects trigger source. This setting is effective only when a trigger mode other than
"Auto" has been selected.

"Internal" The trigger event is executed by "Execute Trigger".

"Internal
(Baseband A/
B)"

(two-path instruments only)
The trigger event is executed by the trigger signal from the second path

"External
(TRIGGER 1 /
2)"

The trigger event is executed with the aid of the active edge of an exter-
nal trigger signal.
The trigger signal is supplied via the TRIGGER connector.
The polarity, the trigger threshold and the input impedance of the
TRIGGER input can be set in the "Global Trigger/Clock Settings" dialog.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​SOURce ​ on page 87
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Sync. Output to External Trigger
(enabled for Trigger Source External)

Enables/disables output of the signal synchronous to the external trigger event.

For R&S SMBV instruments:

For or two or more R&S SMBVs configured to work in a master-slave mode for synchro-
nous signal generation, configure this parameter depending on the provided system trig-
ger event and the properties of the output signal. See the table below for an overview of
the required settings.
Table 3-1: Typical Applications

System Trigger Application "Sync. Output to External Trig-
ger"

Common External Trigger event for
the master and the slave instru-
ments

All instruments are synchronous to
the external trigger event

ON

All instruments are synchronous
among themselves but starting the
signal from first symbol is more
important than synchronicity with
external trigger event

OFF

Internal trigger signal of the master
R&S SMBV for the slave instru-
ments

All instruments are synchronous
among themselves

OFF

"On" Corresponds to the default state of this parameter.
The signal calculation starts simultaneously with the external trigger
event but because of the instrument’s processing time the first samples
are cut off and no signal is outputted. After elapsing of the internal pro-
cessing time, the output signal is synchronous to the trigger event.
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"Off" The signal output begins after elapsing of the processing time and starts
with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequences
with signal duration comparable with the processing time of the instru-
ment.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​EXTernal: ​SYNChronize: ​OUTPut ​
on page 84

Trigger Delay
Sets the trigger signal delay in samples on external triggering or on internal triggering via
the second path.

Sets the trigger signal delay in samples on external triggering.

This enables the R&S Signal Generator to be synchronized with the device under test or
other external devices.

For two-path instruments, the delay can be set separately for each of the two paths.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger[: ​EXTernal<ch>]: ​DELay ​ on page 87
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OBASeband: ​DELay ​ on page 84

Trigger Inhibit
Sets the duration for inhibiting a new trigger event subsequent to triggering. The input is
to be expressed in samples.

In the "Retrigger" mode, every trigger signal causes signal generation to restart. This
restart is inhibited for the specified number of samples.

This parameter is only available on external triggering or on internal triggering via the
second path.

For two-path instruments, the trigger inhibit can be set separately for each of the two
paths.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger[: ​EXTernal<ch>]: ​INHibit ​ on page 88
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OBASeband: ​INHibit ​ on page 85
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3.8.2 Marker Mode

The marker output signal for synchronizing external instruments is configured in the
marker settings section "Marker Mode".

The R&S SMBV supports only two markers.

Marker Mode
Selects a marker signal for the associated "MARKER" output.

"As defined in
Slots"

The marker defined for each slot separately in the burst editor is used.
The name of the marker is displayed to the right of the selection. Defi-
nition of the slot marker is described in ​chapter 3.10, "Slot Marker Def-
inition", on page 54.

"Slot" A slot clock with the slot period specified under Period is generated on
the output connector. The marker signal is generated after every speci-
fied number of slots.
It is important to be aware of the variation in the GSM/EDGE slot length
between 156 and 157 symbols. At a slot length of 156 symbols, a period
of 1 symbol and a symbol rate of 270.833 ksymb/s the clock is
0.577 ms, and at 157 symbols it is 0.580 ms

"Restart" A marker signal is generated at the start of each ARB sequence.

"Frame " A frame clock with the frame period specified under Period is generated
on the output connector. The marker signal is generated after every
specified number of frames.
A GSM/EDGE frame has 1250 symbols. At a symbol rate of 270.833
ksymb/s and a period of 1 the clock is 4.615 ms.

"Pulse" A regular marker signal is generated. The pulse frequency is defined
by entering a divider. The frequency is derived by dividing the sample
rate by the divider. The input box for the divider opens when "Pulse" is
selected, and the resulting pulse frequency is displayed below it.
The maximum pulse frequency is half the symbol rate.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​PULSe: ​DIVider ​ on page 93
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​PULSe[: ​FREQuency] ​
on page 93

"Pattern " A marker signal that is defined by a bit pattern is generated. The pattern
has a maximum length of 64 bits and is defined in an input field which
opens when pattern is selected.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​PATTern ​ on page 92
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"ON/OFF
Period"

A regular marker signal that is defined by an ON/OFF ratio is generated.
A period lasts one ON and OFF cycle.
The "ON Time" and "OFF Time" are each expressed as a number of
samples and are set in an input field which opens when ON/OFF ratio
is selected.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​ONTime ​ on page 92
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​OFFTime ​ on page 92

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​MODE ​ on page 91

3.8.3 Marker Delay

The delay of the signals on the MARKER outputs is set in the"Marker Delay" section.

The marker delay functions are available for R&S SMx and R&S AMU instruments only.

The R&S SMBV supports only two markers.

Marker x Delay
Enters the delay between the marker signal at the marker outputs and the start of the
frame or slot.

If the setting "Fix marker delay to dynamic range" is enabled, the setting range is restricted
to the dynamic range. In this range the delay of the marker signals can be set without
restarting the marker and signal.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​DELay ​ on page 90

Current Range without Recalculation
Displays the dynamic range within which the delay of the marker signals can be set with-
out restarting the marker and signal.

The delay can be defined by moving the setting mark.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​DELay: ​MINimum ​ on page 90
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut<ch>: ​DELay: ​MAXimum ​ on page 90
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Fix marker delay to current range
Restricts the marker delay setting range to the dynamic range. In this range the delay
can be set without restarting the marker and signal.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​TRIGger: ​OUTPut: ​DELay: ​FIXed ​ on page 89

3.8.4 Clock Settings

The Clock Settings is used to set the clock source and a delay if required.

The clock functions are available for R&S SMx and R&S AMU instruments only.

Sync. Mode
(for R&S SMBV only)

Selects the synchronization mode.

This parameter is used to enable generation of very precise synchronous signal of several
connected R&S SMBVs.

Note: If several instruments are connected, the connecting cables from the master
instrument to the slave one and between each two consecutive slave instruments must
have the same length and type.
Avoid unnecessary cable length and branching points.

"None" The instrument is working in stand-alone mode.

"Sync. Master" The instrument provides all connected instrument with its synchronisa-
tion (including the trigger signal) and reference clock signal.

"Sync. Slave" The instrument receives the synchronisation and reference clock signal
from another instrument working in a master mode.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​CLOCk: ​SYNChronization: ​MODE ​ on page 81

Set Synchronization Settings
(for R&S SMBV only)

Performs automatically adjustment of the instrument's settings required for the synchro-
nization mode, selected with the parameter "Synchronization Mode".

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​CLOCk: ​SYNChronization: ​EXECute ​ on page 81

Clock Source
Selects the clock source.

"Internal" The internal clock reference is used to generate the symbol clock.
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"External" The external clock reference is fed in as the symbol clock or multiple
thereof via the CLOCK connector.
The symbol rate must be correctly set to an accuracy of +/-2 % (see
data sheet).
The polarity of the clock input can be changed with the aid of "Global
Trigger/Clock Settings".
In the case of two-path instruments this selection applies to path A.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​CLOCk: ​SOURce ​ on page 80

Clock Mode
Enters the type of externally supplied clock.

"Symbol" A symbol clock is supplied via the CLOCK connector.

"Bit" A bit clock is supplied via the CLOCK connector; the symbol clock is
derived internally from this.

"Multiple Sym-
bol"

A multiple of the symbol clock is supplied via the CLOCK connector;
the symbol clock is derived internally from this.

"Fractional
Symbol"

A fraction of the symbol clock is supplied via the CLOCK connector; the
symbol clock is derived internally from this.

Note: This selection is only available for external clock signals with a
clock rate of at least 200 Hz.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​CLOCk: ​MODE ​ on page 79

Clock Multiplier
Enters the multiplication factor for clock type "Multiple".

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​CLOCk: ​MULTiplier ​ on page 79

Symbol Clock Divider
Enters the divider for clock type "Fraction".

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM: ​CLOCk: ​DIVider ​ on page 80

Measured External Clock
Indicates the measured frequency of the external clock signal. This enables the user to
permanently monitor the frequency of the externally introduced clock.

This information is displayed only if the external clock source has been selected.

SCPI command: 
CLOC:INP:FREQ?

3.8.5 Global Settings

The buttons in this section lead to submenu for general trigger, clock and mapping set-
tings.
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This settings are available for R&S SMx and R&S AMU instruments only.

Global Trigger/Clock Settings
Calls the "Global Trigger/Clock/Input Settings" dialog.

This dialog is used among other things for setting the trigger threshold, the input impe-
dance and the polarity of the clock and trigger inputs.

In the case of two-path instruments, these settings are valid for both paths.

The parameters in this menu affect all digital modulations and standards, and are descri-
bed in chapter "Global Trigger/Clock/Input Settings" in the Operating Manual.

User Marker / AUX I/O Settings
Calls the "User Marker AUX I/O Settings" menu, used used to map the connector on the
rear of the instruments.

See also "User Marker / AUX I/O Settings" in the Operating Manual.

3.9 Burst Editor

To call the burst editor, select a slot from the graphical display in the GSM/EDGE menu.

At the top of the menu the structure of the current burst type for the selected slot is
displayed. Individual fields of the burst are color-coded:

Field Color

Data, Fixed, Mixed, Stealing white

Training Sequences: TSC, ETSC, SYNC yellow

Tail, extended Tail green

Guard, extended Guard blue
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The rest of the menu displays the data contained in fields predefined by the standard for
the current burst type. Data fields with variable content can be edited. The value at which
they are currently set is shown on a button. Pressing the button activates the value that
has been entered. Values in fields with permanently predefined content are not highligh-
ted in any way.

The following sections list all possible settings and displays for the various burst types.
If a setting applies only to a particular burst type, this is mentioned for the parameter
concerned.

Burst Type
Selects burst type.

The available burst types depend on the selected "Symbol Rate Mode".

Note: "Higher Symbol Rate Mode", AQPSK modulations and higher order modulation
schemes (16QAM and 32QAM) are available for instruments equipped with option R&S
SMx/AMU-K41 only.

"Normal
(GMSK/Full
Rate)"

(Normal Symbol Rate)
The useful data is transmitted in the Normal Burst (NB).
A normal burst carries 2*58 = 116 encrypted bits.
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"Normal
(GMSK/Half
Rate)"

(Normal Symbol Rate)
The useful data is transmitted in the Normal burst.
Half rate user 1 is transmitted in all the frames with an even index
(frames 0, 2, 4, etc.) and half rate user 2 is transmitted in the frames
with an odd index (frames 1, 3, etc.)
See also ​chapter 3.3, "Mode Framed (single)", on page 18.

"Normal
(AQPSK/Full
Rate - Full
Rate)"

The data of pair of users is multiplexed on the two VAMOS subchannels
of a single physical radio resource.
See also ​chapter 2.1, "VAMOS (Voice services over Adaptive Multi-
user channels on One Slot)", on page 8.

"Normal
(AQPSK/Full
Rate - Half
Rate)"

Three users are using the same radio resource, one full rate VAMOS
user on the subchannel 1 and two half rate VAMOS users on the sub-
channel 2.
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"Normal
(AQPSK/Half
Rate - Half
Rate)"

A single time slot is shared by four users: two VAMOS subchannels,
each used by two half rate users.

"Normal
(8PSK/EDGE)"

(Normal Symbol Rate)
The higher bit clock associated with EDGE achieves correspondingly
higher data transfer rates.
If a frame contains an active EDGE burst, the higher bit clock (3 x sym-
bol clock) is always output on the clock outputs. If the EDGE burst is
removed from the frame, the lower bit clock (=symbol clock) is auto-
matically output again.
An EDGE burst carries 2x(3*58) = 348 encrypted bits.

"Normal
(16QAM)"

(Normal Symbol Rate)
Selects a normal burst with 16QAM modulation scheme (4 bits per
symbol).
A normal 16QAM burst carries 2x(4*58) = 464 encrypted bits.

"Normal
(32QAM)"

(Normal Symbol Rate)
Selects a normal burst with 32QAM modulation scheme (5 bits per
symbol).
A normal 32QAM burst carries 2x(5*58) = 580 encrypted bits.
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"Synchroniza-
tion"

(Normal Symbol Rate)
The Synchronization burst is sent by the base station only and is used
for bit synchronization. For this purpose it contains a 64-bit Extended
Training Sequence.

"Frequency
Correction"

(Normal Symbol Rate)
The Frequency Correction burst is sent by the base station only. The
user equipment uses the burst in order to synchronize with the carrier
frequency and to compensate for any possible Doppler effect.

"Dummy" (Normal Symbol Rate)
The Dummy burst is sent by the base station only. It acts as a modu-
lation signal when there is no data burst available. This burst type is
defined in the standard and has an unalterable, precisely defined data
pattern.

"Access" (Normal Symbol Rate)
This burst type is sent by a user equipment to a base station as the first
burst, in order to determine the timing advance. It is used for synchro-
nizing with the base station.

"All Data
(GMSK)"

(Normal Symbol Rate)
This and the following normal symbol rate burst types are not defined
in the standard. They serve as the output basis for defining a new burst
type with user-programmable data content for test purposes.
An All_Data GMSK burst carries 148 encrypted bits.

"All Data
(AQPSK)"

An All_Data AQPSK burst carries 148 encrypted bits per subchannel.

Burst Editor



GSM/EDGE User InterfaceGSM/EDGE

47Operating Manual 1171.5254.12 ─ 12

"All Data
(8PSK/EDGE)"

(Normal Symbol Rate)
An All_Data EDGE burst carries 3x148 = 444 encrypted bits.

"All Data
(16QAM)"

(Normal Symbol Rate)
An All_Data 16QAM burst carries 4x148 = 592 encrypted bits.

"All Data
(32QAM)"

(Normal Symbol Rate)
An All_Data 32QAM burst carries 5x148 = 740 encrypted bits.

"HSR (QPSK)" (Higher Symbol Rate)
Selects a higher symbol rate burst with QPSK modulation scheme (2
bits per symbol).
A higher symbol rate burst carries 2*69 = 138 unmodulated encrypted
bits, i.e. a HSR QPSK burst carries 2x(2*69) = 276 encrypted bits.

"HSR
(16QAM)"

(Higher Symbol Rate)
Selects a higher symbol rate burst with 16QAM modulation scheme (4
bits per symbol).
A HSR 16QAM burst carries 4x(2*69) = 552 encrypted bits.

"HSR
(32QAM)"

(Higher Symbol Rate)
Selects a higher symbol rate burst with 32QAM modulation scheme (5
bits per symbol).
A HSR 32QAM burst carries 5x(2*69) = 690 encrypted bits.

"HSR All Data
(QPSK)"

(Higher Symbol Rate)
This and the following higher symbol rate burst types are not defined in
the standard. They serve as the output basis for defining a new burst
type with user-programmable data content for test purposes.
A HSR All_Data QPSK burst carries 2x177 = 354 encrypted bits.
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"HSR All Data
(16QAM)"

(Higher Symbol Rate)
A HSR All_Data 16QAM burst carries 4x177 = 708 encrypted bits.

"HSR All Data
(32QAM)"

(Higher Symbol Rate)
A HSR All_Data 32QAM burst carries 5x177 = 885 encrypted bits.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>: ​TYPE ​ on page 97

Save-Recall Slots
Calls the Save/Recall Slot menu.

From the Save/Recall Slot menu the File Select windows for saving and recalling slot
configurations and the File Manager can be called (see ​chapter 3.5, "Save Recall Frame/
Slots", on page 21).

SCPI command: 
n.a.

User x
When burst type "Normal (Half Rate)" is selected the users can be set separately in menu
sections User 1 and User 2.

SCPI command: 
n.a.

SCPIR
Selects the SCPIR.

Use the ​Modulation/Filter dialog to define eight different values for SCPIR. You may
select from the values displayed.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​SCPIRatio ​ on page 98

Slot Level
Sets the level for the selected slot.

"Off" Attenuation is maximum. The slot is inactive.

"Attenuated" Level is reduced by the level attenuation set in "Slot Attenuation".

"Full" The level corresponds to the level indicated in the display.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​LEVel ​ on page 97
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Slot Attenuation
Selects the level attenuation for the Slot Level Attenuated setting. You can use the "Power
Ramping" menu (see ​chapter 3.7, "Power Ramping/Slot Attenuation", on page 29) to
define seven different values for level attenuation. You may select from the values dis-
played.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ATTenuation ​ on page 98

Filter
(for Higher Symbol Rate slots and instruments equipped with K41 only)

Selects whether a Narrow Pulse Shape or a Wide Pulse Shape filter should be use for
the selected burst type and modulation.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​FILTer: ​TYPE ​ on page 99

Multislot Configuration
Enables the previously set multislot mode.

Since multislot involves connecting multiple slots to a single user channel, this configu-
ration is possible for Normal (Full Rate) bursts, Normal (8PSK/EDGE) burst and EDGE
Evolution bursts.

A number of multislot groups can be defined within a frame. These are highlighted when
the frame structure is displayed in the main menu (see ​chapter 3.3, "Mode Framed (sin-
gle)", on page 18).

The first slot in a multislot group is the master slot. This determines the parameters of all
the slots in the group. All the slots in a multislot group therefore have identical parameters.

The multislot settings are valid for all the slots in the frames of a multiframe configuration.
If slots 1 and 2 are connected, for example, both these slots are connected in all the
frames of the multiframe signal.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​MULTislot<st0>: ​STATe ​ on page 101

Number of Slots
Defines the number of consecutive slots that will be linked to a multislot.
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The multislot always starts with the current slot. The value range therefore depends on
the current slot index. A maximum of 8 slots (slot 0 to slot 7) can be combined: 1 ... (8 -
current index).

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​MULTislot<st0>: ​COUNt ​ on page 99

Extended Tail Bits
Displays the data content in the "ETail" data field of the Access burst.

Extended Tail Bits fields are 8 bits long and permanently set at 0011 1010.

SCPI command: 
n.a.

Tail Bits
Displays the data content in the "Tail" data field.

The content depends on the "Burst Type":
● NORMAL(GMSK...), NORMAL(AQPSK...), Synchronization, Frequency Correction,

Dummy and Access
"Tail Bit" field is 3 Bits long and permantly set at 000.

● NORMAL(8PSK/EDGE)
"Tail Bit" field is 9 Bits long and permantly set at 1 1111 1111.

● NORMAL(16QAM)
"Tail Bit" field is 12 Bits long and permantly set at 0001 0110 0110.

● NORMAL(32QAM)
"Tail Bit" field is 15 Bits long and permantly set at 111 1001 1100 1110.

SCPI command: 
n.a.

Data for Data Field of Slot
Selects a data source for the DATA field.

If a burst contains multiple DATA fields, these are treated as a continuous field, and for
instance a pseudo-random sequence is continued without interruption from one DATA
field to the next.

You may choose from the following data sources:

"All 0, All1" 0 data or 1 data is internally generated.

"PRBS" PRBS data in accordance with the IUT-T with period lengths between
29-1 and 223-1 are internally generated.

"Pattern" A user-definable bit pattern with a maximum length of 64 bits is inter-
nally generated.
The bit pattern is defined in the "Pattern" input box.
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"Data List" Uses data from a programmable data list. The data can be generated
internally with the aid of the binary editor in the R&S Signal Generator
or externally by the user with the aid of any editor.
Data lists are selected from the Select List file menu.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA ​ on page 100
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA: ​PATTern ​ on page 101
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA: ​DLISt: ​CATalog ​ on page 101
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​DATA: ​DLISt ​ on page 100

Use Stealing Flag
Sets the Use Stealing Flag feature. The setting applies to both S fields. If not used, the
flag stealing bit is allocated to the data field concerned, which then becomes 58 data bits
long instead of 57.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​SFLag: ​USE ​ on page 102

Stealing Flag
Sets a value for the Stealing Flag feature. The setting applies to both S fields.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​SFLag ​ on page 102

Training Sequence Set
Determine whether the GMSK normal burst or VAMOS subchannel uses TSC set 1 or
set 2.

Assign different TSC set to each of the two subcahnnels to ensure that the training
sequences configured for the VAMOS subchannels have a very low cross-correlation.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​TSC: ​SET ​ on page 103

TSC
Selects the "Training Sequence Code".

There are 8 predefined training sequences to choose from in each case; those for GSM
are 26 bits long and those for EDGE are 78 bits.

A user-defined training sequence can be created in the User TSC field and is then also
available for selection.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​TSC: ​SELect ​ on page 103
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TSC Pattern
Edits selected training sequence.

When a sequence has been changed, the TSC field displays the indication "User".

When a frame/slot is saved the amended training sequence is also saved.

User-defined training sequences can be used among other things to test the reaction of
receivers to interference-laden training sequences (e.g. 1 bit toggle).

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>][: ​SOURce]: ​TSC: ​USER ​ on page 103

Ext Training Seq ETSC
Selects the Extended Training Sequence Code for the Synchronization burst.

There is a choice of three predefined, 64-bit extended training sequences. Additionally a
user-defined extended training sequence can be defined in the User ETSC field and is
then also available for selection.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ETSC ​ on page 104

ETSC Pattern
Edits selected ETSC for the Synchronization burst.

When a sequence has been changed, the "Ext Training Seq ETSC" field also displays
"User" as a possible choice.

When a frame/slot is saved, the changed extended training sequence is also saved.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​ETSC: ​USER ​ on page 104

Training Sequence Sync
Selects Training Sequence Sync for the Access burst.

There is a choice of three predefined, 41-bit training sequences sync. Additionally user-
defined training sequence sync can be defined in the "User Sync" field and is then also
available for selection.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​SYNC: ​SELect ​ on page 104

Sync Pattern
Edits the Training Sequence Sync for the Access burst.
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When a sequence has been changed, the "Training Sequence Sync" field also displays
"User" as a possible choice.

When a frame/slot is saved the amended training sequence sync is also saved.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​SYNC: ​USER ​ on page 105

Fixed
Selects the data content of the Fixed field in the Frequency Correction burst. There is a
choice of two fixed, 142-bit data contents prescribed by the standard. The "User" data
content can also be selected. This pattern can be edited in the Fixed Pattern field and
must likewise be 142 bits long.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​FCORrection: ​FIXed ​ on page 105

Fixed Pattern
Displays the data content of the Fixed field in the Frequency Correction burst when "Fixed
Standard" or "Compact" is selected.

Enter the data content of the Fixed field in the Frequency Correction burst when "Fixed
User" is selected. The pattern is 142 bits long.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​FCORrection: ​FIXed: ​PATTern ​ on page 105

Mixed
Displays the data content of the Mixed field in the Dummy burst. It contains a fixed, 142-
bit data content prescribed by the standard.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​
USER<ch>]: ​DUMMy: ​MIXed: ​PATTern ​ on page 106

Guard
Displays the data content of the Guard field in binary notation.

In order for a frame to contain exactly 1250 bits for normal burst and 1500 for higher
symbol rate burst as prescribed in the GSM standard, the length of the Guard fields is
different for different slots (see table).

 Normal Symbol Rate  

Slot # 0, 4 1 .. 3, 5 .. 7

Guard Length 9 symbol periods 8 symbol periods
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 Higher Symbol Rate  

Slot # 0, 2, 4, 6 1, 3, 5, 7

Guard Length 11 symbol periods 10 symbol periods

If the field Ignore "1/4 symbol (slot length 156 symbols) / Ignore ½ symbol (slot length
187 symbols)" is enabled, all slots are 156 respectively 187 symbols long. The extra ¼
resp. ½ symbols is omitted. The guard field for the burst always has the same length
regardless of the slot index.

For normal burst, a frame is therefore 1248 symbols long instead of 1250.

Respectively, the length of the frame in a higher symbol rate burst is then 1496 symbols
long instead of 1500 symbols.

SCPI command: 
n.a.

Extended Guard
Displays the data content of the Extended Guard field in the Access burst.

In order for a frame to contain exactly 1250 symbols as prescribed in the GSM standard,
the length of the extended Guard fields is different for different slots:

The field length is 68 bits in slots 1, 2, 3, 5, 6, 7 and 69 bits in slots 0 and 4.

If the field "Ignore 1/4 symbol (slot length 156 symbols)" is enabled, all slots are 156
symbols long. The extra ¼ symbol is omitted. The extended guard field for the burst
always has the same length regardless of the slot index. A frame is therefore 1248 sym-
bols long in place of 1250.

SCPI command: 
n.a.

Slot Marker Definition
Calls the menu for defining the marker signal at slot level. This menu is described in the
​chapter 3.10, "Slot Marker Definition", on page 54.

SCPI command: 
n.a.

3.10 Slot Marker Definition

To call the "Control List Editor" for defining the marker signal at slot level, use the "Slot
Marker Definition" button in the burst editor of the GSM/EDGE menu.

The marker signals thus defined will only become effective if the "As defined in slot"
marker type in the "Trigger/Marker/Clock menu" is selected.
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The structure of the selected slot (in the example, synchronization burst) is displayed in
the menu header. The individual fields of the burst are color-coded.

The available marker signals are also color-coded. In the left "Configure Control Sig-
nal" section, each individual signal is assigned a color; a check in the check box shows
the marker for which the "As defined in slot" marker type has been selected.

In the next section, "Select Ramp to Edit", the signal characteristics are graphically dis-
played.

The ramps can be assigned the exact bit position in the signal by means of
● The schematic display of the slot above the section.
● The bit scale below the marker/control signal characteristic.
● The display of the current cursor position in the "Cursor" menu section if the cursor

marks the ramp. The field at the selected position in the slot is displayed on the side.
The bit position of the cursor within this field is displayed below

The ramps can be set either graphically in the "Select Ramp to Edit" section or in the
table of the "Positions Marker x" section. To make the setting easy, a selection of preset
ramp characteristics is offered in the "Preset Ramp Marker x" section.

Configure Control Signal
Displays the color the marker and the Burst Gate signal has been assigned.

Displays whether the "CList" marker type has been selected in the Trigger/Marker/Clock
menu for this marker.

Displays whether the "As defined in Slot" source has been selected for this marker signal
in the individual setting menu.

The source can be selected here as well and will then be used in the associated menus.
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Note: The burst gate signal is only displayed and cannot be edited.

SCPI command: 
​[: ​SOURce<hw>]: ​BB: ​GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​USER<ch>]: ​TRIGger: ​
OUTPut: ​TAG ​ on page 106

Select Ramp to Edit
Graphically edit marker signals.

For this purpose, the cursor is set to the position where a ramp is required. The ramp is
generated by pressing Enter (e.g. clicking on the rotary knob). Any number of ramps can
be defined per marker. Each of the generated ramp positions will be saved even if the
definition of another ramp produces a low/low or high/high transition. The ramps are dis-
played as dashed lines.

Existing ramps can be shifted after the cursor has been placed on the ramp and Enter
has been pressed – it then changes color twice. The ramp is shifted by using the cursor
keys or the rotary knob. The new position is determined by pressing Enter again.

Ramps can be deleted by means of the BACKSPACE key after the cursor has been
placed on the ramp.

SCPI command: 
n.a.

Total List Length
Displays the length of the list in bits.

SCPI command: 
n.a.

Preset Type
Activates presetting for the ramp characteristic of the selected control signal. The pre-
setting is selected with select "Preset Type" and activated by means of the "Preset" but-
ton.

You can select from:

"All Up" The marker signal is continuously high.

"All Down" The marker signal is continuously low.

"Ramp Up" The marker signal contains a ramp from low to high. The ramp is shifted
to the center of the displayed signal area and can subsequently be
shifted as required.

"Ramp Down" The marker signal contains a ramp from high to low. The ramp is shifted
to the center of the displayed signal area and can subsequently be
shifted as required.

"Ramp Up/
Down"

The marker signal contains a ramp from low to high and from high to
low. The ramps are symmetrically shifted around the center of the dis-
played signal area and can subsequently be shifted as required.
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"Ramp Down/
Up"

The marker signal contains a ramp from high to low and from low to
high. The ramps are symmetrically shifted around the center of the dis-
played signal area and can subsequently be shifted as required.

SCPI command: 
n.a.

Edit Table
Opens table by using the "Edit Table" button.

The ramps of the selected signal can be edited in the table. When the table is opened,
the current configuration of the selected marker/control signal is displayed.

The bit position is specified in the "Ramp Position" column, the high or low signal status
in the "Ramp State" column. At the end of the list, there is always a blank row for entering
new values.

The changes are accepted in the graphic display after pressing the "Accept" button.

SCPI command: 
n.a.

Cursor Position
Enters the cursor position.

In the graphic display, the cursor is positioned according to the entry.

Vice versa, graphically shifting the cursor will change the displayed value.

The field at the selected position in the slot is displayed on the side. The bit position of
the cursor within this field is displayed below.

SCPI command: 
n.a.

Zoom/Visible
Zooms the displayed area of the control list. The designation of the button changes from
"Zoom in" to "Zoom out".

With long control lists, the displayed area can be zoomed around the current "Cursor
Position".

Parameter "Visible/Bits Visible" determines the number of symbols/bits to be displayed.
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Ramps outside the displayed area are not lost by zooming.

SCPI command: 
n.a.

Save
Saves the settings made in the "Slot Marker" menu into a file with file name format
GsmMarkSlotDefP<x>F<y>S<z>U<w>.dm_iqc, where:
● x the path number,
● y is the Frame number,
● z is the Slot number and
● w is the User number.

SCPI command: 
n.a.
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4 Remote-Control Commands
This subsystem contains the commands for setting the GSM/EDGE standards.

The R&S Signal Generator can be used to define multiframe signals. This requires the
inclusion of the keyword FRAMe in the commands concerned. However, this keyword is
optional in the case of single-frame signals.
When the keyword is not specified the commands are compatible with the corresponding
commands in the R&S SMIQ generator family (see also the list comparing R&S SMU and
R&S SMIQ commands).

In Frame (Double) mode (SOURce:BB:GSM:MODE DOUBle) the suffix to FRAMe defines
the frame to which the setting applies.

In Frame (Single) mode the keyword FRAMe is ignored and can be omitted.

The suffix to SLOT defines the slot to which the setting applies. The 8 slots of which a
frame is composed can be selected.

In case of remote control, suffix counting for slots corresponds to the suffix counting with
GSM (slot 0 to slot 7). SCPI prescribes that suffix 1 is the default state and used when
no specific suffix is specified. Therefore, slot 1 (and not slot 0) is selected when no suffix
is specified.

When burst type HALF is selected, the suffix to USER defines the half rate user to which
the setting applies. For all other burst types the keyword USER is ignored and can be
omitted.

The suffix to SUBChannel distinguish between the VAMOS subchannels. For all other
burst types the keyword SUBChannel is ignored and can be omitted.

SOURce<hw>
For one-path instruments, the keyword SOURce is optional and can be omitted.

The numeric suffix to SOURce distinguishes between signal generation for path A and
path B in the case of two-path instruments:
● SOURce[1] = path A

The keyword SOURce is optional and can be omitted

● SOURce2 = path B
The keyword SOURce is mandatory, i.e. the command must contain the keyword with
suffix 2.

OUTPut<ch>
The numeric suffix to OUTPut distinguishes between the available markers.

Only two markers are available for the R&S SMBV, i.e. the allowed values for the suffix
are 1 or 2.

Placeholder <root>
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For commands that read out or save files in the default directory, the default directory is
set using command MMEM:CDIRectory. The examples in this description use the place
holder <root> in the syntax of the command.

● D:\ - for selecting the internal hard disk of Windows instruments

● E:\ - for selecting the memory stick which is inserted at the USB interface of Windows
instruments

● /var/<instrument> - for selecting the internal flash card of Linux instrument,
where <instrument> is the instument name, e.g. smbv.

● /usb - for selecting the memory stick which is inserted at the USB interface of Linux
instrument.

4.1 Primary Commands

[:​SOURce<hw>]: ​BB:​GSM:​FLENgth ​....................................................................................60
[:​SOURce<hw>]: ​BB:​GSM:​SLENgth ​...................................................................................61
[:​SOURce<hw>]: ​BB:​GSM:​FONE​.......................................................................................61
[:​SOURce<hw>]: ​BB:​GSM:​FRAMe<di>: ​REPetitions ​.............................................................62
[:​SOURce<hw>]: ​BB:​GSM:​ISLength ​...................................................................................62
[:​SOURce<hw>]: ​BB:​GSM:​MODE​.......................................................................................62
[:​SOURce<hw>]: ​BB:​GSM:​PRESet ​.....................................................................................63
[:​SOURce<hw>]: ​BB:​GSM:​SATTenuation<ch> ​.....................................................................63
[:​SOURce<hw>]: ​BB:​GSM:​SETTing:​CATalog ​......................................................................64
[:​SOURce<hw>]: ​BB:​GSM:​SETTing:​DELete ​........................................................................64
[:​SOURce<hw>]: ​BB:​GSM:​SETTing:​LOAD ​..........................................................................64
[:​SOURce<hw>]: ​BB:​GSM:​SETTing:​STORe​........................................................................65
[:​SOURce<hw>]: ​BB:​GSM:​SETTing:​STORe:​FAST​...............................................................65
[:​SOURce<hw>]: ​BB:​GSM:​SMODe ​.....................................................................................65
[:​SOURce<hw>]: ​BB:​GSM:​SRATe ​......................................................................................66
[:​SOURce<hw>]: ​BB:​GSM:​SRATe:​MODE​...........................................................................66
[:​SOURce<hw>]: ​BB:​GSM:​STATe​......................................................................................66
[:​SOURce<hw>]: ​BB:​GSM:​WAVeform:​CREate ​.....................................................................67

[:SOURce<hw>]:BB:GSM:FLENgth <FLength>

(for R&S WinIQSIM2 only)

(Framed mode only)

The command sets the sequence length of the generated arbitrary waveform file in num-
ber of frames.

For GSM mode Framed Double, this command is query only, since the length of the
generated ARB file is determined by the parameter Frame Repetition ( ​[: ​
SOURce<hw>]: ​BB: ​GSM: ​FRAMe<di>: ​REPetitions ​) for both frames:

Sequence Length = Frame Repetition of Frame 1 + Frame Repetition of Frame 2.

For GSM mode (BB:GSM:MODE) set to Unframed, the length of the generated ARB file
is set in symbols with the command ​[: ​SOURce<hw>]: ​BB: ​GSM: ​SLENgth ​.

 

Primary Commands



Remote-Control CommandsGSM/EDGE

61Operating Manual 1171.5254.12 ─ 12

Parameters:
<FLength> float

Range: 1 frame  to  13 107 frames
*RST: 1 frame

Example: BB:GSM:MODE SING
selects framed single GSM mode.
BB:GSM:FLEN 2
sets the sequence length to 2 frames.
BB:GSM:MODE DOUB
selects framed double GSM mode.
BB:GSM:FRAM1:REP 2
sets the frame repetition of frame 1 to 2.
BB:GSM:FRAM2:REP 1
sets the frame repetition of frame 2 to 1.
BB:GSM:FLEN?
queries the sequence length.
Response: 3

[:SOURce<hw>]:BB:GSM:SLENgth <SLength>

for R&S WinIQSIM2 only

(Unframed mode only)

The command sets the sequence length of the generated arbitrary waveform file in num-
ber of symbols.

For GSM mode (BB:GSM:MODE) set to Single or Double, the length of the generated ARB
file in symbols is a read-only value and depends on the sequence length in frames, set
with the command BB:GSM:FLEN.

Parameters:
<SLength> integer

Range: 1 symbol  to  16 384 000 symbols
*RST: 1250 symbols

Example: BB:GSM:MODE UNFR
selects unframed GSM mode.
BB:GSM:SLEN 5000
sets the sequence length to 5000 symbols.

[:SOURce<hw>]:BB:GSM:FONE <FOne>

A modulating bit stream consisting of consecutive ones is used for inactive slots (accord-
ing to GSM 05.04).

If this parameter is disabled, the inactive slots are filled in with 0.

Parameters:
<FOne> 0 | 1 | OFF | ON

*RST: OFF
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Example: BB:GSM:FONE ON
A modulating bit stream consisting of consecutive ones is used for
inactive slots.

[:SOURce<hw>]:BB:GSM:FRAMe<di>:REPetitions <Repetitions>

The command defines the number of repetitions for the selected frame in GSM mode
Frame (Double).

Suffix: 
<di>

.
[1]|2

Parameters:
<Repetitions> integer

Range: 1  to  500000
*RST: 1 / 1

Example: BB:GSM:MODE DOUB
selects GSM mode Frame (Double).
BB:GSM:FRAM2:REP 10
sets 10 repetitions for frame 2.

[:SOURce<hw>]:BB:GSM:ISLength <ISLength>

Selects constant slot length.

For Normal Symbol Rate mode, the command selects whether the 1/4 symbol of a GSM
slot (length = 156.25 symbols) will be ignored (ON) or compensated for by an extra symbol
every 4th slot (OFF). When ON is selected, all slots are 156 symbols long. When OFF is
selected, some slots are 157 symbols long.

For Higher Symbol Rate mode, the command selects whether the 1/2 symbol of a aver-
age slot with a length of 187.5 symbols will be ignored (ON) or compensated for by an
extra symbol every secend slot (OFF). When ON is selected, all slots are 187 symbols
long. When OFF is selected, some slots are 188 symbols long.

Parameters:
<ISLength> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:GSM:SRAT:MODE NSR
selects normal symbol rate mode.
BB:GSM:ISL ON
selects a constant length of 156 symbols for all slots.

[:SOURce<hw>]:BB:GSM:MODE <Mode>

The command selects GSM mode.
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Parameters:
<Mode> UNFRamed | SINGle | DOUBle | MULTiframe

UNFRamed
Modulation signal without slot and frame structure.
SINGle
Modulation signal consisting of one frame.
DOUBle
Modulation signal in which two frames are defined and then com-
bined by some method into a single multiframe signal.
MULTiframe
Multiframe signal.
*RST: SINGle

Example: BB:GSM:MODE SING
sets the "Single Frame" GSM mode. Only the commands for defin-
ing a single frame are valid.

[:SOURce<hw>]:BB:GSM:PRESet

The command sets all modulation parameters, including slot settings, to their GSM
default values. The ON status (SOURce:BB:GSM:STATe ON | OFF) is not affected by
this command.

Example: BB:GSM:PRES
resets all GSM settings to default values.

Usage: Event

[:SOURce<hw>]:BB:GSM:SATTenuation<ch> <SAttenuation>

The command sets up to seven different values for level attenuation. The various values
are defined by the suffix to SATTenuation. These values are used when defining the
level attenuation of individual slots with the aid of the command ​[: ​SOURce<hw>]: ​BB: ​
GSM[: ​FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​USER<ch>]: ​
ATTenuation ​.

Suffix: 
<ch>

.
1 .. 7

Parameters:
<SAttenuation> float

Range: 0  to  60 dB
Increment: 0.01 dB
*RST: 0 dB
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Example: BB:GSM:MODE SING
selects GSM mode Frame (Single).
BB:GSM:SLOT1:LEV ATT
sets level attenuation mode for slot 1.
BB:GSM:SATT1 12dB
sets the level attenuation for selection A1 to 12 dB.
BB:GSM:SLOT1:ATT A1
sets the level attenuation for slot 1 to 12 dB.

[:SOURce<hw>]:BB:GSM:SETTing:CATalog?

This command reads out the files with GSM settings in the default directory. The default
directory is set using command MMEM:CDIRectory. Only files with the file extension
*.gsm will be listed.

Return values: 
<Catalog> string

Example: MMEM:CDIR '<root>\user\dig_mod
sets the default directory to <root>\user\dig_mod.
BB:GSM:SETT:CAT?
reads out all the files with GSM settings in the default directory.
Response: gsm_1

Usage: Query only

[:SOURce<hw>]:BB:GSM:SETTing:DELete <Filename>

This command deletes the selected file with GSM settings. The directory is set using
command MMEM:CDIRectory. A path can also be specified, in which case the files in
the specified directory are read. The file extension may be omitted. Only files with the file
extension *.gsm will be deleted.

Setting parameters: 
<Filename> string

Example: BB:GSM:SETT:DEL 'gsm_1'
deletes file gsm_1.

Usage: Setting only

[:SOURce<hw>]:BB:GSM:SETTing:LOAD <Filename>

This command loads the selected file with GSM settings. The directory is set using com-
mand MMEM:CDIRectory. A path can also be specified, in which case the files in the
specified directory are read. The file extension may be omitted. Only files with the file
extension *.gsm will be loaded.

Setting parameters: 
<Filename> string
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Example: BB:GSM:SETT:LOAD 'gsm_1'
loads file gsm_1

Usage: Setting only

[:SOURce<hw>]:BB:GSM:SETTing:STORe <Filename>

This command stores the current GSM settings into the selected file. The directory is set
using command MMEM:CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. Only the file name has to be entered. GSM settings
are stored as files with the specific file extensions *.gsm.

Setting parameters: 
<Filename> string

Example: BB:GSM:SETT:STOR 'gsm_1'
stores the current GSM settings into file gsm_1.

Usage: Setting only

[:SOURce<hw>]:BB:GSM:SETTing:STORe:FAST <Fast>

Determines whether the instrument performs an absolute or a differential storing of the
settings.

Enable this function to accelerate the saving process by saving only the settings with
values different to the default ones.

Note: This function is not affected by the "Preset" function.

Parameters:
<Fast> 0 | 1 | OFF | ON

*RST: 1

[:SOURce<hw>]:BB:GSM:SMODe <SMode>

The command selects the modulation signal for the mode Unframed (:BB:GSM:MODE
UNFR). The modulation type and filter type are set in accordance with the selection.

The available simulation modes depend on the selected symbol rate:
● Normal Symbol Rate - GSM, EDGE (8PSK), AQPSK, 16QAM and 32QAM
● Higher Symbol Rate - HSR QPSK, HSR 16QAM and HSR 32QAM.

Note: "Higher Symbol Rate" Mode and "Simulation Modes" AQPSK, 16QAM, 32QAM,
HSR QPSK, HSR 16QAM and HSR 32QAM are available for instruments equipped with
option R&S SMx/AMU-K41 only.

Parameters:
<SMode> GSM | EDGE | N16Qam | N32Qam | HQPSk | H16Qam | H32Qam |

AQPSk
*RST: GSM
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Example: BB:GSM:MODE UNFR
sets unframed mode.
BB:GSM:SRAT:MODE HSR
selects higher symbol rate mode.
BB:GSM:SMOD H16Q
selects a HSR 16QAM modulation signal for the Unframed mode.
BB:GSM:SRAT:MODE NSR
selects normal symbol rate mode.
BB:GSM:SMOD GSM
selects a GSM modulation signal for the Unframed mode.

Options: N16Qam | N32Qam | HQPSk | H16Qam | H32Qam | AQPSk
require R&S SMx/AMU-K41

[:SOURce<hw>]:BB:GSM:SRATe <SRate>

The command sets the symbol clock. Possible units are Hz, kHz, MHz, Sym/s, kSym/s,
MSym/s.

Parameters:
<SRate> float

Range: 400 Hz  to  25 MHz
Increment: 0.001 Hz
*RST: 270.833 kHz
Default unit: Hz

Example: BB:GSM:SRAT 270.9 kHz
sets the symbol clock to 270.9 kHz.

[:SOURce<hw>]:BB:GSM:SRATe:MODE <Mode>

Set the symbol rate mode, i.e. determines whether a normal bursts (NB) or higher symbol
rate bursts (HB) will be generated.

Parameters:
<Mode> NSRate | HSRate

*RST: NSRate

Example: BB:GSM:SRAT HSR
selects higher symbol rate mode
BB:GSM:SRAT?
queries the symbol clock.
Response: 325

Options: (for instruments equipped with option K41 only)

[:SOURce<hw>]:BB:GSM:STATe <State>

The command switches on the modulation in accordance with the GSM standard. Any
other standards or digital modulation that may be in the ON state will be automatically
turned OFF (in case of two-path instruments, this affects the same path).
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Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:GSM:STAT ON
switches GSM modulation on.

[:SOURce<hw>]:BB:GSM:WAVeform:CREate <Filename>

for R&S WinIQSIM2 only

This command creates a waveform using the current settings of the GSM/EDGE menu.
The file name is entered with the command. The file is stored with the predefined file
extension *.wv. The file name and the directory it is stored in are user-definable.

Setting parameters: 
<Filename> string

Example: MMEM:CDIR '<root>\user\waveform'
sets the default directory to <root>\user\waveform.
BB:GSM:WAV:CRE 'gsm_1'
creates the waveform file gsm.wv in the default directory.

Usage: Setting only

4.2 Save Recall Frame/Slots

FRAMe<di>
Value range [1]|2
SLOT<st0>
Value range 0|[1] .. 7
USER<ch>
Value range [1]|2
[:​SOURce<hw>]: ​BB:​GSM:​FRAMe<di>: ​ULISt:​CATalog ​.........................................................68
[:​SOURce<hw>]: ​BB:​GSM:​FRAMe<di>: ​ULISt:​DELete ​..........................................................68
[:​SOURce<hw>]: ​BB:​GSM:​FRAMe<di>: ​ULISt:​LOAD ​............................................................68
[:​SOURce<hw>]: ​BB:​GSM:​FRAMe<di>: ​ULISt:​STORe​..........................................................69
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​PREDefined: ​CATalog ​.............................................69
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​PREDefined: ​LOAD ​.................................................69
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

PREDefined: ​CATalog ​.............................................................................................70
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

PREDefined: ​LOAD ​.................................................................................................70
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

ULISt:​CATalog ​......................................................................................................70
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[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
ULISt:​DELete ​........................................................................................................71

[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
ULISt:​LOAD ​..........................................................................................................71

[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
ULISt:​STORe​........................................................................................................71

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:CATalog?

This command reads out the files with user defined frame settings in the default directory.
The default directory is set using command MMEM:CDIRectory. Only files with the file
extension *.gsm_fu and *.gsm_hfu will be listed.

Return values: 
<Catalog> string

Example: MMEM:CDIR '<root>\user\frames'
sets the default directory to <root>\user\frames.
BB:GSM:FRAM:ULIS:CAT?
reads out all the files with user defined frame settings in the default
directory.
Response: 'NB_all'
the file NB_all with a user defined frame setting is available.

Usage: Query only

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:DELete <Filename>

This command deletes the selected file with user defined frame settings. The directory
is set using command MMEM:CDIRectory. A path can also be specified, in which case
the files in the specified directory are read. The file extension may be omitted. Only files
with the file extension *.gsm_fu and *.gsm_hfu will be deleted.

Setting parameters: 
<Filename> string

Example: BB:GSM:FRAM:ULIS:DEL 'NB_all'
deletes file NB_all.

Usage: Setting only

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:LOAD <Filename>

This command loads the selected file with user defined frame settings. The directory is
set using command MMEM:CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. The file extension may be omitted. Only files with
the file extension *.gsm_fu and *.gsm_hfu will be loaded.

Setting parameters: 
<Filename> string
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Example: BB:GSM:FRAM:ULIS:LOAD 'NB_all'
loads file NB_all.

Usage: Setting only

[:SOURce<hw>]:BB:GSM:FRAMe<di>:ULISt:STORe <Filename>

This command stores the current frame settings into the selected file. The directory is set
using command MMEM:CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. Only the file name has to be entered. User Stand-
ards are stored as files with the specific file extensions *.gsm_fu and *.gsm_hfu.

Setting parameters: 
<Filename> string

Example: BB:GSM:FRAM:ULIS:STOR 'EDGE_all'
stores the current frame settings into file EDGE_all.

Usage: Setting only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDefined:CATalog?

This command reads out the files with predefined frame settings. The directory is preset,
therefore a path cannot be specified.

Return values: 
<Catalog> string

Example: BB:GSM:FRAM:PRED:CAT?
reads out all the files with predefined frame settings.
Response: 'Edge0, EdgeAll, GsmEdge,
NormalBurst0, NormalBurstAll'
the file names of the files with the predefined frame settings are
returned

Usage: Query only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:PREDefined:LOAD <Filename>

This command loads the selected file with predefined frame settings. The directory is pre-
set, therefore a path cannot be specified.

Setting parameters: 
<Filename> string

Example: BB:GSM:MODE SING
selects GSM mode Frame (Single).
BB:GSM:SRAT:MODE NSR
selects normal symbol rate.
BB:GSM:FRAM:PRED:LOAD 'Edge0'
loads file Edge0 with the predefined frame setting Edge Burst in
Slot 0.
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Usage: Setting only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:PREDefined:CATalog?

This command reads out the files with predefined slot settings. The directory is preset,
therefore a path cannot be specified.

The numeric suffixes in all key words are irrelevant for this command.

Return values: 
<Catalog> string

Example: BB:GSM:SLOT:PRED:CAT?
reads out all the files with predefined frame settings.
Response: GSM_NB_PN9_TSC0,EDGE_NB_PN9_TSC0
the files GSM_NB_PN9_TSC0 and EDGE_NB_PN9_TSC0 are avail-
able.

Usage: Query only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:PREDefined:LOAD <Filename>

This command loads the selected file with predefined slot settings. The directory is pre-
set, therefore a path cannot be specified.

Setting parameters: 
<Filename> string

Example: BB:GSM:SLOT:PRED:LOAD 'GSM_NB_PN9_TSC0'
loads the settings of file GSM_NB_PN9_TSC0 for slot 1 in frame 1.

Usage: Setting only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ULISt:CATalog?

This command reads out the files with user defined slot settings in the default directory.
The default directory is set using command MMEM:CDIRectory. Only files with the file
extension *.gsm_slu and *.gsm_hslu will be listed.

Return values: 
<Catalog> string

Example: MMEM:CDIR '<root>\user\slots
sets the default directory to <root>\user\slots.
BB:GSM:SLOT:ULIS:CAT?
reads out all the files with user defined slot settings in the default
directory.
Response: 'test_01'
the file test_01 with a user defined slot setting is available.
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Usage: Query only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ULISt:DELete <Filename>

This command deletes the selected file with user defined slot settings. The directory is
set using command MMEM:CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. The file extension may be omitted. Only files with
the file extension *.gsm_slu and *.gsm_hslu will be deleted.

Setting parameters: 
<Filename> string

Example: BB:GSM:SLOT:ULIS:DEL 'NB'
deletes file NB.

Usage: Setting only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ULISt:LOAD <Filename>

This command loads the selected file with user defined slot settings. The directory is set
using command MMEM:CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. The file extension may be omitted. Only files with
the file extension *.gsm_slu and *.gsm_hslu will be loaded.

Setting parameters: 
<Filename> string

Example: BB:GSM:SLOT:ULIS:LOAD 'NB'
loads file NB.

Usage: Setting only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ULISt:STORe <Filename>

This command stores the current slot settings into the selected file. The directory is set
using command MMEM:CDIRectory. A path can also be specified, in which case the
files in the specified directory are read. Only the file name has to be entered. User slots
are stored as files with the specific file extensions *.gsm_slu and *.gsm_hslu.

Setting parameters: 
<Filename> string

Example: BB:GSM:SLOT:ULIS:STOR 'EDGE'
stores the current slot settings into file EDGE.

Usage: Setting only
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4.3 Modulation/Filter Settings

4.3.1 Modulation Settings

[:​SOURce<hw>]: ​BB:​GSM:​FORMat​....................................................................................72
[:​SOURce<hw>]: ​BB:​GSM:​EDGE:​FORMat​..........................................................................72
[:​SOURce<hw>]: ​BB:​GSM:​FSK:​DEViation ​...........................................................................72
[:​SOURce<hw>]: ​BB:​GSM:​AQPSk:​FORMat​.........................................................................73
[:​SOURce<hw>]: ​BB:​GSM:​H16Qam: ​FORMat​......................................................................73
[:​SOURce<hw>]: ​BB:​GSM:​H32Qam: ​FORMat​......................................................................73
[:​SOURce<hw>]: ​BB:​GSM:​HQPSk:​FORMat​.........................................................................74
[:​SOURce<hw>]: ​BB:​GSM:​N16Qam: ​FORMat​......................................................................74
[:​SOURce<hw>]: ​BB:​GSM:​N32Qam: ​FORMat​......................................................................75
[:​SOURce<hw>]: ​BB:​GSM:​AQPSk:​ANGLe<ch0> ​.................................................................75
[:​SOURce<hw>]: ​BB:​GSM:​AQPSk:​SCPIR<ch0> ​..................................................................75

[:SOURce<hw>]:BB:GSM:FORMat <Format>

The command selects the modulation type.

Parameters:
<Format> MSK | FSK2

*RST: MSK

Example: BB:GSM:FORM FSK2
selects the GSM modulation type FSK.

[:SOURce<hw>]:BB:GSM:EDGE:FORMat?

The command queries the modulation type in the case of EDGE. The modulation type is
permanently set to 8PSK.

Return values: 
<Format> P8EDge

Example: BB:GSM:EDGE:FORM?
queries the modulation type.
Response:    "P8ED"

Usage: Query only

[:SOURce<hw>]:BB:GSM:FSK:DEViation <Deviation>

The command sets the modulation deviation when :BB:GSM:FORMat FSK2 is selected.
The range of values depends on the symbol rate (:BB:GSM:SRATe) : 0.1 x fSymb ... 1.5
* fSymb (max. 10 MHZ).

The maximum deviation is 10 MHz.
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Parameters:
<Deviation> float

Range: 0.1xf(symb)  to  1.5xf(symb);(10MHz)
*RST: 67.708 kHz
Default unit: Hz

Example: BB:GSM:FORM FSK2
selects the GSM modulation type GFSK.
BB:GSM:FSK:DEV 37.6 kHz
sets the FSK deviation to 37.6 kHz.

[:SOURce<hw>]:BB:GSM:AQPSk:FORMat?

The command queries the modulation type. The modulation type is permanently set to
AQPSK.

Return values: 
<Format> AQPSk

*RST: AQPSk

Example: BB:GSM:AQPS:FORM?
queries the modulation type.
Response:    "AQPSk"

Usage: Query only

Options: R&S SMx/AMU-K41

[:SOURce<hw>]:BB:GSM:H16Qam:FORMat?

The command queries the modulation type.

Return values: 
<Format> QAM16EDge

*RST: QAM16EDge

Example: BB:GSM:SRAT:MODE HSR
selects higher symbol rate mode.
BB:GSM:H16Q:FORM?
queries the modulation type.
Response:    "QAM16ED"

Usage: Query only

Options: (for Higher Symbol Rate and instruments equipped with option
K41 only)

[:SOURce<hw>]:BB:GSM:H32Qam:FORMat?

The command queries the modulation type.
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Return values: 
<Format> QAM32EDge

*RST: QAM32EDge

Example: BB:GSM:SRAT:MODE HSR
selects higher symbol rate mode.
BB:GSM:H32Q:FORM?
queries the modulation type.
Response:    QAM32ED

Usage: Query only

Options: (for Higher Symbol Rate and instruments equipped with option
K41 only)

[:SOURce<hw>]:BB:GSM:HQPSk:FORMat?

The command queries the modulation type.

Return values: 
<Format> QEDGe

*RST: QEDGe

Example: BB:GSM:SRAT:MODE HSR
selects higher symbol rate mode.
BB:GSM:HQPS:FORM?
queries the modulation type.
Response:    QQDG

Usage: Query only

Options: (for Higher Symbol Rate and instruments equipped with option
K41 only)

[:SOURce<hw>]:BB:GSM:N16Qam:FORMat?

The command queries the modulation type.

Return values: 
<Format> QAM16EDge

*RST: QAM16EDge

Example: BB:GSM:SRAT:MODE NSR
selects normal symbol rate mode.
BB:GSM:N16Q:FORM?
queries the modulation type.
Response:    QAM16ED

Usage: Query only

Options: (for instruments equipped with option K41 only)
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[:SOURce<hw>]:BB:GSM:N32Qam:FORMat?

The command queries the modulation type.

Return values: 
<Format> QAM32EDge

*RST: QAM32EDge

Example: BB:GSM:SRAT:MODE NSR
selects normal symbol rate mode.
BB:GSM:N32Q:FORM?
queries the modulation type.
Response:    QAM32ED

Usage: Query only

Options: (for instruments equipped with option K41 only)

[:SOURce<hw>]:BB:GSM:AQPSk:ANGLe<ch0> <Angle>

Sets the angle alpha.

Suffix: 
<ch0>

.
0 .. 7

Parameters:
<Angle> float

Range: 0.0001  to  89.9999
Increment: 0.0001
*RST: 45

Example: BB:GSM:AQPS:ANGL5 50
Options: R&S SMx/AMU-K41

[:SOURce<hw>]:BB:GSM:AQPSk:SCPIR<ch0> <Scpir>

Sets the Subchannel Power Imbalance Ratio (SCPIR). It is related to the angle α as
follows:

SCPIR = 20 * log10(tan α) dB,

where the value of α shall be chosen such that |SCPIR|≤10dB.

Suffix: 
<ch0>

.
0 .. 7

Parameters:
<Scpir> float

Range: -115.1625  to  115.1625
Increment: 0.0001
*RST: 0
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Example: BB:GSM:AQPS:SCPIR5 -10
BB:GSM:AQPS:ANGL5?
Response: 17.5484

Options: R&S SMx/AMU-K41

4.3.2 Filter Settings

[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​TYPE​..............................................................................76
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​PARameter ​.....................................................................76
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​OSAMpling ​......................................................................77
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​OSAMpling: ​AUTO​............................................................77
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​AQPSK:​TYPE​.................................................................77
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​EDGE:​TYPE​...................................................................77
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​N16Qam: ​TYPE​................................................................78
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​N32Qam: ​TYPE​................................................................78
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​H16Qam: ​TYPE​................................................................78
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​H32Qam: ​TYPE​................................................................78
[:​SOURce<hw>]: ​BB:​GSM:​FILTer:​HQPSk:​TYPE​..................................................................78

[:SOURce<hw>]:BB:GSM:FILTer:TYPE?

The command sets the filter type GAUSs. This is the only possible selection in the case
of digital standard GSM.

Return values: 
<Type> GAUSs

*RST: GAUSs

Example: BB:GSM:FILT:TYPE  GAUS
sets the filter type GAUSS.

Usage: Query only

[:SOURce<hw>]:BB:GSM:FILTer:PARameter <Parameter>

The command sets the filter parameter. For Gaussian filter the BxT is the product of the
bandwidth and the symbol duration. The default value for GSM modulation is 0.3 and for
Gauss Linearized (EDGE), BT = 0.3.

Parameters:
<Parameter> float

Range: 0.15  to  2.5
Increment: 0.01
*RST: 0.3

Example: BB:GSM:FILT:PAR 0.4
sets the BT value to 0.4.
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[:SOURce<hw>]:BB:GSM:FILTer:OSAMpling <OSampling>

The command sets the upsampling factor.

Parameters:
<OSampling> integer

Range: 1  to  32
*RST: 32

Example: BB:GSM:FILT:OSAM 32
sets the upsampling factor to 32.

[:SOURce<hw>]:BB:GSM:FILTer:OSAMpling:AUTO <Auto>

The command activates/deactivates the upsampling factor state. If activated, the most
sensible parameter values are selected. The value depends on the coherence check. If
deactivated, the values can be changed manually.

Parameters:
<Auto> 0 | 1 | OFF | ON

*RST: ON

Example: BB:GSM:FILT:OSAM:AUTO ON
the most sensible parameters are selected automatically.

[:SOURce<hw>]:BB:GSM:FILTer:AQPSK:TYPE?

Queries the filter type for AQPSK modulation. The filter is permanently set to GAUSS
linearized.

Return values: 
<Type> LGAuss

*RST: LGAuss

Usage: Query only

Options: R&S SMx/AMU-K41

[:SOURce<hw>]:BB:GSM:FILTer:EDGE:TYPE?

The command sets the filter type LGAuss. This is the only possible selection in the case
of digital standard GSM EDGE.

Return values: 
<Type> LGAuss

Example: BB:GSM:FILT:EDGE:TYPE LGA
sets the filter type Gauss linearized.

Usage: Query only
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[:SOURce<hw>]:BB:GSM:FILTer:N16Qam:TYPE?

Queries filter for 16QAM signal. The filter is permanently set to GAUSS linearized.

Return values: 
<Type> LGAuss

Example: BB:GSM:FILT:N16Q:TYPE?
queries the filter type.
Response: LGA

Usage: Query only

Options: K41

[:SOURce<hw>]:BB:GSM:FILTer:N32Qam:TYPE?

Queries filter for 32QAM signal. The filter is permanently set to GAUSS linearized.

Return values: 
<Type> LGAuss

Example: BB:GSM:FILT:N32Q:TYPE?
queries the filter type.
Response: LGA

Usage: Query only

Options: K41

[:SOURce<hw>]:BB:GSM:FILTer:H16Qam:TYPE <Type>

Sets the filter for HSR 16QAM signal.

Parameters:
<Type> ENPShape | EWPShape

*RST: ENPShape

Example: BB:GSM:FILT:H16Q:TYPE ENPS

[:SOURce<hw>]:BB:GSM:FILTer:H32Qam:TYPE <Type>

Sets the filter for HSR 32QAM signal.

Parameters:
<Type> ENPShape | EWPShape

*RST: ENPShape

Example: BB:GSM:FILT:H32Q:TYPE ENPS

[:SOURce<hw>]:BB:GSM:FILTer:HQPSk:TYPE <Type>

Sets the filter for HSR QPSK signal.
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Parameters:
<Type> ENPShape | EWPShape

*RST: ENPShape

Example: BB:GSM:FILT:HQPS:TYPE ENPS

4.4 Clock Settings

This section lists the remote control commands, necessary to configure the clock.

The clock settings are available for R&S SMx and R&S AMU instruments only.

[:​SOURce<hw>]: ​BB:​GSM:​CLOCk: ​MODE​...........................................................................79
[:​SOURce<hw>]: ​BB:​GSM:​CLOCk: ​MULTiplier ​.....................................................................79
[:​SOURce<hw>]: ​BB:​GSM:​CLOCk: ​DIVider ​..........................................................................80
[:​SOURce<hw>]: ​BB:​GSM:​CLOCk: ​SOURce ​........................................................................80
[:​SOURce<hw>]: ​BB:​GSM:​CLOCk: ​SYNChronization: ​EXECute ​..............................................81
[:​SOURce<hw>]: ​BB:​GSM:​CLOCk: ​SYNChronization: ​MODE​.................................................81

[:SOURce<hw>]:BB:GSM:CLOCk:MODE <Mode>

The command enters the type of externally supplied clock (:BB:GSM:CLOCk:SOURce
EXT).

When MSYMbol is used, a multiple of the symbol clock is supplied via the CLOCK con-
nector and the symbol clock is derived internally from this. The multiplier is entered with
the command :BB:GSM:CLOCk:MULTiplier.

When FSYMbol is used, a fraction of the symbol clock is supplied via the CLOCK con-
nector and the symbol clock is derived internally from this. The divisor is entered with the
command :BB:GSM:CLOCk:DIVider. This selection is only possible for external sig-
nals with a clock rate of at least 200 Hz.

For two-path instruments, the only numerical suffix allowed for SOURce is 1, since the
external clock source is permanently allocated to path A.

Parameters:
<Mode> SYMBol | MSYMbol | BIT | FSYMbol

*RST: SYMBol

Example: BB:GSM:CLOC:MODE SYMB
selects clock type "Symbols", i.e. the supplied clock is a symbol
clock.

[:SOURce<hw>]:BB:GSM:CLOCk:MULTiplier <Multiplier>

The command specifies the multiplier for clock type "Multiple Symbols"
(:BB:GSM:CLOCk:MODE MSYM) in the case of an external clock source.
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For two-path instruments, the only numerical suffix allowed for SOURce is 1, since the
external clock source is permanently allocated to path A.

Parameters:
<Multiplier> integer

Range: 1  to  64
Increment: 1
*RST: 4

Example: BB:GSM:CLOC:SOUR EXT
selects the external clock source. The clock is supplied via the
CLOCK connector.
BB:GSM:CLOC:MODE MSYM
selects clock type "Multiple Symbols", i.e. the supplied clock has
a rate which is a multiple of the symbol rate.
BB:GSM:CLOC:MULT 12
the multiplier for the external clock rate is 12.

[:SOURce<hw>]:BB:GSM:CLOCk:DIVider <Divider>

The command specifies the divider for clock type "Fractional Symbols"
(:BB:GSM:CLOCk:MODE FSYM) in the case of an external clock source.

For two-path instruments, the only numerical suffix allowed for SOURce is 1, since the
external clock source is permanently allocated to path A.

Parameters:
<Divider> float

Range: 1  to  65536
Increment: 1
*RST: 4

Example: BB:GSM:CLOC:SOUR EXT
selects the external clock source. The clock is supplied via the
CLOCK connector.
BB:GSM:CLOC:MODE FSYM
selects clock type "Fractional Symbols", i.e. the supplied clock has
a rate which is a fraction of the symbol rate.
BB:GSM:CLOC:DIV 2
the divider for the external clock rate is 2.

[:SOURce<hw>]:BB:GSM:CLOCk:SOURce <Source>

The command selects the clock source.

For two-path instruments, selecting EXTernal is only possible for path A, since the exter-
nal clock source is permanently allocated to path A; selecting AINternal is only possible
for path B.
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Parameters:
<Source> INTernal | EXTernal | AINTernal

INTernal
The internal clock reference is used.
EXTernal
The external clock reference is supplied to the CLOCK connector.
*RST: INTernal

Example: BB:GSM:CLOC:SOUR EXT
selects an external clock reference. The clock is supplied via the
CLOCK connector.
BB:GSM:CLOC:MODE SYMB
specifies that a symbol clock is supplied via the CLOCK connector.

[:SOURce<hw>]:BB:GSM:CLOCk:SYNChronization:EXECute

Performs automatically adjustment of the instrument's settings required for the synchro-
nization mode, set with the command BB:GSM:CLOC:SYNC:MODE.

Example: BB:GSM:CLOC:SYNC:MODE MAST
the instrument is configured to work as a master one.
BB:GSM:CLOC:SYNC:EXEC
all synchronizations settings are adjusted accordingly.

Usage: Event

[:SOURce<hw>]:BB:GSM:CLOCk:SYNChronization:MODE <Mode>

Selects the synchronization mode.

This parameter is used to enable generation of very precise synchronous signal of several
connected R&S SMBVs.

Note:

If several instruments are connected, the connecting cables from the master instrument
to the slave one and between each two consecutive slave instruments must have the
same length and type.

Avoid unnecessary cable length and branching points.
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Parameters:
<Mode> NONE | MASTer | SLAVe

NONE
The instrument is working in stand-alone mode.
MASTer
The instrument provides all connected instrument with its syn-
chronisation clock (including the trigger signal) and its reference
clock signal.
SLAVe
The instrument receives the synchronisation and reference clock
signal from another instrument working in a master mode.
*RST: NONE

Example: BB:GSM:CLOC:SYNC:MODE MAST
the instrument is configured to work as a master one.

4.5 Trigger Settings

The trigger settings are available for R&S SMx and R&S AMU instruments only.

EXTernal<ch>
The numeric suffix to EXTernal<ch> distinguishes between the external trigger via the
TRIGGER 1 (suffix 1) and TRIGGER 2 (suffix 2) connector.

[:​SOURce<hw>]: ​BB:​GSM[:​TRIGger]:​SEQuence ​..................................................................82
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​ARM:​EXECute ​..............................................................83
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​EXECute ​......................................................................84
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​EXTernal: ​SYNChronize: ​OUTPut​.....................................84
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OBASeband: ​DELay ​......................................................84
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OBASeband: ​INHibit ​.......................................................85
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​RMODe ​.......................................................................85
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​SLENgth ​......................................................................86
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​SLUNit ​.........................................................................86
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​SOURce ​......................................................................87
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger[:​EXTernal<ch>]: ​DELay ​..................................................87
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger[:​EXTernal<ch>]: ​INHibit ​..................................................88
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​EXTernal: ​CLOCk: ​DELay ​...............................................88
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​EXTernal: ​CLOCk: ​INHibit ​...............................................88

[:SOURce<hw>]:BB:GSM[:TRIGger]:SEQuence <Sequence>

The command selects the trigger mode.

 

Trigger Settings



Remote-Control CommandsGSM/EDGE

83Operating Manual 1171.5254.12 ─ 12

Parameters:
<Sequence> AUTO | RETRigger | AAUTo | ARETrigger | SINGle

AUTO
The frames are generated continuously.
RETRigger
The frames are generated continuously. A trigger event (internal
or external) causes a restart.
AAUTo
The frames are generated only when a trigger event occurs. After
the trigger event the signal is generated continuously. Signal gen-
eration is stopped with command
SOUR:BB:GSM:TRIG:ARM:EXEC and started again when a trig-
ger event occurs.
ARETrigger
The frames are generated only when a trigger event occurs. The
device automatically toggles to RETRIG mode. Every subsequent
trigger event causes a restart. Signal generation is stopped with
command SOUR:BB:GSM:TRIG:ARM:EXEC and started again
when a trigger event occurs.
SINGle
The signal is generated only when a trigger event occurs. After the
trigger event the signal is generated once to the set sequence
length (SOUR:BB:GSM:TRIG:SLEN). Every subsequent trigger
event causes a restart.
*RST: AUTO

Example: BB:GSM:SEQ AAUT
sets the "Armed_auto" trigger mode; the device waits for the first
trigger (e.g. with *TRG) and then generates the frames continu-
ously.

[:SOURce<hw>]:BB:GSM:TRIGger:ARM:EXECute

The command stops signal generation for trigger modes Armed_Auto and Armed_Ret-
rigger. A subsequent internal or external trigger event restarts signal generation.

Example: BB:GSM:TRIG:SOUR INT
sets internal triggering.
BB:GSM:TRIG:SEQ ARET
sets Armed_Retrigger mode, i.e. every trigger event causes signal
generation to restart.
BB:GSM:TRIG:EXEC
executes a trigger, signal generation is started.
BB:GSM:TRIG:ARM:EXEC
signal generation is stopped.
BB:GSM:TRIG:EXEC
executes a trigger, signal generation is started again.

Usage: Event
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[:SOURce<hw>]:BB:GSM:TRIGger:EXECute

The command executes a trigger. The internal trigger source must be selected using the
command :BB:GSM:TRIGger:SOURce INTernal and a trigger mode other than
AUTO must be selected using the command :BB:GSM:SEQ.

Example: BB:GSM:TRIG:SOUR INT
sets internal triggering.
BB:GSM:SEQ RETR
sets Retrigger mode, i.e. every trigger event causes signal gen-
eration to restart.
BB:GSM:TRIG:EXEC
executes a trigger.

Usage: Event

[:SOURce<hw>]:BB:GSM:TRIGger:EXTernal:SYNChronize:OUTPut <Output>

(enabled for "Trigger Source" External)

Enables/disables output of the signal synchronous to the external trigger event.

For R&S SMBV instruments:

See also ​"Sync. Output to External Trigger" on page 36for a detailed description of the
applications of this setting.

Parameters:
<Output> 0 | 1 | OFF | ON

ON
The signal calculation starts simultaneously with the external trig-
ger event but because of the instrument's processing time the first
samples are cut off and no signal is outputted. After elapsing of
the internal processing time, the output signal is synchronous to
the trigger event.
OFF
The signal output begins after elapsing of the processing time and
starts with sample 0, i.e. the complete signal is outputted.
This mode is recommended for triggering of short signal sequen-
ces with signal duration comparable with the processing time of
the instrument.
*RST: ON

Example: BB:GSM:TRIG:SOUR EXT
sets external triggering.
BB:GSM:TRIG:EXT:SYNC:OUTP ON
enables synchrounous output to external trigger

[:SOURce<hw>]:BB:GSM:TRIGger:OBASeband:DELay <Delay>

The command specifies the trigger delay (expressed as a number of symbols) for trig-
gering by the signal from the second path.
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Parameters:
<Delay> float

Range: 0 Symbols  to  2^32-1 Symbols
Increment: 1 symbol for CLOCk:SOURce EXT 0.01; symbols for

CLOCk:SOURce INT
*RST: 0 Symbols

Example: BB:GSM:TRIG:SOUR OBAS
sets for path A the internal trigger executed by the signal from the
second path (path B).
BB:GSM:TRIG:OBAS:DEL 200
sets a delay of 200 symbols for the trigger.

[:SOURce<hw>]:BB:GSM:TRIGger:OBASeband:INHibit <Inhibit>

The command specifies the number of symbols by which a restart is to be inhibited fol-
lowing a trigger event. This command applies only for triggering by the second path.

Parameters:
<Inhibit> integer

Range: 0 Symbols  to  2^32-1 (67 108 863) Symbols
Increment: 1 Symbol
*RST: 0 Symbols

Example: BB:GSM:TRIG:SOUR OBAS
sets for path A the internal trigger executed by the signal from the
second path (path B).
BB:GSM:TRIG:OBAS:INH 200
sets a restart inhibit for 200 symbols following a trigger event.

[:SOURce<hw>]:BB:GSM:TRIGger:RMODe?

The command queries the status of frame generation for all trigger modes with GSM/
EDGE modulation on.

Return values: 
<RMode> STOP | RUN

RUN
the GSM/EDGE signal is generated. A trigger event occurred in
the triggered mode.
STOP
the GSM/EDGE signal is not generated. A trigger event did not
occur in the triggered modes, or signal generation was stopped by
the command :BB:GSM:TRIG:ARM:EXECute (armed trigger
modes only).
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Example: BB:GSM:TRIG:SOUR EXT
sets external triggering via the TRIGGER 1 connector.
BB:GSM:TRIG:MODE ARET
selects the Armed_Retrigger mode.
BB:GSM:TRIG:RMOD?
queries the status of frame generation.
Response: RUN
the frame is generated, an external trigger was executed.

Usage: Query only

[:SOURce<hw>]:BB:GSM:TRIGger:SLENgth <SLength>

The command defines the length of the signal sequence to be output in the "Single" trigger
mode. The unit is defined with command SOUR:BB:GSM:TRIG:SLUNit. It is possible
to output deliberately just part of a frame, an exact sequence of a frame, or a defined
number of repetitions of a frame.

Parameters:
<SLength> integer

Range: 1 Symbol  to  2^32-1 Symbols
*RST: 1 Symbol

Example: BB:GSM:SEQ SING
sets trigger mode Single.
BB:GSM:TRIG:SLUN SYMB
sets unit symbol for the entry of signal duration.
BB:GSM:TRIG:SLEN 200
sets signal duration of 200 symbols. 200 symbols will be output
after the next trigger event.

[:SOURce<hw>]:BB:GSM:TRIGger:SLUNit <SLunit>

The command defines the unit for the entry of the length of the signal sequence
(SOUR:BB:GSM:TRIG:SLEN) to be output in the "Single" trigger mode
(SOUR:BB:GSM:SEQ SING).

Parameters:
<SLunit> FRAMe | SYMBol

*RST: FRAMe

Example: BB:GSM:SEQ SING
sets trigger mode Single.
BB:GSM:TRIG:SLUN FRAM
sets unit frame for the entry of signal duration.
BB:GSM:TRIG:SLEN 2
sets signal duration of 2 frames. The current frame will be output
twice after the next trigger event.
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[:SOURce<hw>]:BB:GSM:TRIGger:SOURce <Source>

The command selects the trigger source.

Parameters:
<Source> INTernal | EXTernal | BEXTernal | OBASeband | ECLock

INTernal
Triggering is executed by means of the Trigger command in the
case of remote control, and by means of "Execute Trigger" in the
case of manual operation.
EXTernal
Triggering is executed by means of the signal on the TRIGGER 1
connector.
BEXTernal
Triggering is executed by means of the signal on the TRIGGER 2
connector.
OBASeband
Triggering is executed by means of the signal from the second
path (two-path instruments only).
ECLock
Triggering is executed by means of the signal on the CLOCK con-
nector. This signal is also used as clock. The selection is only
available if external clock source (:BB:GSM:CLOC:SOUR EXT) is
selected. In case of two-path instruments, the selection is only
available for baseband path A.
*RST: INTernal

Example: BB:GSM:TRIG:SOUR INT
sets internal triggering.

[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernal<ch>]:DELay <Delay>

The command specifies the trigger delay (expressed as a number of symbols) for external
triggering. The numeric suffix to EXTernal distinguishes between the external trigger via
the TRIGGER 1 (suffix 1) and TRIGGER 2 (suffix 2) connector.

Parameters:
<Delay> float

Range: 0 Symbols  to  2^16-1 Symbols
Increment: 1 symbol for CLOCk:SOURce EXT; 0.01 symbols for

CLOCk:SOURce INT
*RST: 0 Symbols

Example: BB:GSM:TRIG:SOUR EXT
selects an external trigger via the TRIGGER 1 connector.
BB:GSM:TRIG:DEL 200
sets a delay of 200 symbols for the trigger.
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[:SOURce<hw>]:BB:GSM:TRIGger[:EXTernal<ch>]:INHibit <Inhibit>

The command specifies the number of symbols by which a restart is to be inhibited fol-
lowing a trigger event. This command applies only in the case of external triggering. The
numeric suffix to EXTernal distinguishes between the external trigger via the TRIGGER
1 (suffix 1) and TRIGGER 2 (suffix 2) connector.

Parameters:
<Inhibit> integer

Range: 0 symbols  to  2^26-1 Symbols
Increment: 1 Symbol
*RST: 0 Symbols

Example: BB:GSM:TRIG:SOUR EXT
selects an external trigger via the TRIGGER 1 connector.
BB:GSM:TRIG:INH 200
sets a restart inhibit for 200 symbols following a trigger event.

[:SOURce<hw>]:BB:GSM:TRIGger:EXTernal:CLOCk:DELay <Delay>

The command specifies the trigger delay (expressed as a number of symbols) for external
triggering via the clock input.

This command applies only if external clock source (BB:GSM:CLOC:SOUR EXT) and
trigger source external clock (BB:GSM:TRIG:SOUR CLOC) are selected.

For two-path instruments, this command applies only for baseband path A.

Parameters:
<Delay> float

Range: 0 Symbols  to  2^16-1 Symbols
Increment: 1 Symbol
*RST: 0 Symbols

Example: BB:GSM:CLOC:SOUR EXT
selects the external clock source. The clock signal must be provi-
ded at the CLOCK connector.
BB:GSM:TRIG:SOUR ECL
selects an external trigger by means of the external clock.
BB:GSM:TRIG:EXT:CLOC:DEL 200
sets a delay of 200 symbols for the trigger.

[:SOURce<hw>]:BB:GSM:TRIGger:EXTernal:CLOCk:INHibit <Inhibit>

The command specifies the number of symbols by which a restart is to be inhibited fol-
lowing a trigger event. This command applies only if external clock source
(BB:GSM:CLOC:SOUR EXT) and trigger source external clock (BB:GSM:TRIG:SOUR
CLOC) is selected.

For two-path instruments, this command applies only for baseband path A.

Trigger Settings
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Parameters:
<Inhibit> integer

Range: 0 Symbols  to  2^26-1 (67 108 863) Symbols
Increment: 1 Symbol
*RST: 0 Symbols

Example: BB:GSM:CLOC:SOUR EXT
selects the external clock source. The clock signal must be provi-
ded at the CLOCK connector.
BB:GSM:TRIG:SOUR ECL
selects an external trigger by means of the external clock.
BB:GSM:TRIG:EXT:CLOC:INH 200
sets a restart inhibit for 200 symbols following a trigger event.

4.6 Marker Settings

This section lists the remote control commands, necessary to configure the markers.

The marker delay settings are available for R&S SMx and R&S AMU instruments only.

[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut:​DELay: ​FIXed​...................................................89
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut<ch>:​DELay ​......................................................90
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut<ch>:​DELay: ​MAXimum ​......................................90
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut<ch>:​DELay: ​MINimum ​.......................................90
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut<ch>:​MODE​......................................................91
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut<ch>:​ONTime ​...................................................92
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut<ch>:​OFFTime​..................................................92
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut<ch>:​PATTern​..................................................92
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut<ch>:​PERiod: ​SLOT​...........................................92
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut<ch>:​PERiod[: ​FRAMe]​.......................................93
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut<ch>:​PULSe: ​DIVider ​.........................................93
[:​SOURce<hw>]: ​BB:​GSM:​TRIGger:​OUTPut<ch>:​PULSe[: ​FREQuency] ​.................................93

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut:DELay:FIXed <Fixed>

The command restricts the marker delay setting range to the dynamic range. In this range
the delay can be set without restarting the marker and signal. If a delay is entered in
setting ON but is outside this range, the maximum possible delay is set and an error
message is generated.

The numeric suffix in OUTPut has no significance for this command, since the setting
always affects every marker.

Parameters:
<Fixed> 0 | 1 | OFF | ON

*RST: OFF
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Example: BB:GSM:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay <Delay>

The command defines the delay between the signal on the marker outputs and the start
of the frame/slot, expressed in terms of symbols.

Command :BB:GSM:TRIGger:OUTPut:DELay:FIXed can be used to restrict the
range of values to the dynamic range, i.e. the range within which a delay of the marker
signals can be set without restarting the marker and signal.

Parameters:
<Delay> float

Range: 0 Symbols  to  2^24-1 Symbols
Increment: 1 Symbol
*RST: 0 Symbols

Example: BB:GSM:TRIG:OUTP2:DEL 16
sets a delay of 16 symbols for the signal on connector MARKER
2.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay:MAXimum?

The command queries the maximum marker delay for set-
ting :BB:GSM:TRIGger:OUTPut:DELay:FIXed ON.

Return values: 
<Maximum> float

Example: BB:GSM:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.
BB:GSM:TRIG:OUTP:DEL:MAX
queries the maximum of the dynamic range.
Response: '2000'
the maximum for the marker delay setting is 2000 symbols.

Usage: Query only

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:DELay:MINimum?

The command queries the minimum marker delay for set-
ting :BB:GSM:TRIGger:OUTPut:DELay:FIXed ON.

Return values: 
<Minimum> float

Marker Settings
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Example: BB:GSM:TRIG:OUTP:DEL:FIX ON
restricts the marker signal delay setting range to the dynamic
range.
BB:GSM:TRIG:OUTP:DEL:MIN
queries the minimum of the dynamic range.
Response: '0'
the minimum for the marker delay setting is 0 symbols.

Usage: Query only

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:MODE <Mode>

The command defines the signal for the selected marker output.

Parameters:
<Mode> SDEF | FRAMe | SLOT | PULSe | PATTern | RATio | TRIGger

As defined in slots
The marker defined in the burst editor is used.
SLOT
A slot clock with the slot period specified using command
SOUR:BB:GSM:TRIG:OUTP:PER:SLOT is generated on the out-
put connector. The marker signal is generated after every speci-
fied number of slots. It is important to be aware of the variation in
the GSM/EDGE slot length between 156 and 157 symbols. At a
slot length of 156 symbols, a period of 1 symbol and a symbol rate
of 270.833 ksymb/s the clock is 0.577 ms, and at 157 symbols it
is 0.580 ms.
FRAMe
A frame clock with the frame period specified using command
SOUR:BB:GSM:TRIG:OUTP:PER:FRAM is generated on the out-
put connector. The marker signal is generated after every speci-
fied number of frames. A GSM/EDGE frame has 1250 symbols.
At a symbol rate of 270.833 ksymb/s and a period of 1 the clock
is 4.615 ms.
PULSe
A pulsed marker signal is generated. The pulse frequency
PATTern
A marker signal is generated with the aid of a user-definable bit
pattern. The bit pattern is entered with the aid of command
SOURce:BB:GSM:TRIGg:OUTP:PATT. The bit pattern is a max-
imum of 32 bits long.
RATio
A regular marker signal corresponding to the Time Off / Time On
specifications in the commands
SOUR:BB:GSM:TRIGge:OUTP:OFFT and
SOUR:BB:GSM:TRIGg:OUTP:ONT is generated.

*RST: FRAMe

Marker Settings
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Example: BB:GSM:TRIG:OUTP2:MODE PULS
selects the pulsed marker signal on output MARKER 2.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:ONTime <OnTime>
[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:OFFTime <OffTime>

The command sets the number of symbols in a period (ON time + OFF time) during which
the marker signal in setting SOURce:BB:GSM:TRIGger:OUTPut:MODE RATio on the
marker outputs is OFF.

Parameters:
<OffTime> integer

Range: 1 Symbol  to  2^24-1 Symbols
Increment: 1 Symbol
*RST: 1 Symbol

Example: BB:GSM:TRIG:OUTP2:OFFT 20
sets an OFF time of 20 symbols for marker signal 2.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PATTern <Pattern>

The command defines the bit pattern used to generate the marker signal in the setting
SOURce:BB:GSM:TRIGger:OUTPut:MODE PATTern 0 is marker off, 1 is marker on.
The pattern has a maximum length of 64 bits.

Parameters:
<Pattern> integer

*RST: 0

Example: BB:GSM:TRIG:OUTP2:PATT #H81,8
sets a bit pattern.
BB:GSM:TRIG:OUTP2:MODE PATT
activates the marker signal according to a bit pattern on output
MARKER 2.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERiod:SLOT <Slot>

The command sets the repetition rate for the slot clock at the marker outputs.

Parameters:
<Slot> integer

Range: 1 Slot  to  2^26-1 Slots
Increment: 1 Slot
*RST: 1 Slot

Example: BB:GSM:TRIG:OUTP2:MODE SLOT
sets the slot clock for the signal on connector MARKER 2.
BB:GSM:TRIG:OUTP2:PER:SLOT 16
sets a period of 16 slots, i.e. the marker signal is repeated every
16th slot.

Marker Settings



Remote-Control CommandsGSM/EDGE

93Operating Manual 1171.5254.12 ─ 12

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PERiod[:FRAMe] <Frame>

The command sets the repetition rate for the frame clock at the marker outputs.

Parameters:
<Frame> integer

Range: 1 Frame  to  2^26-1 Frames
Increment: 1 Frame
*RST: 1 Frame

Example: BB:GSM:TRIG:OUTP2:MODE FRAM
sets the frame clock for the signal on connector MARKER 2.
BB:GSM:TRIG:OUTP2:PER 16
sets a period of 16 frames, i.e. the marker signal is repeated every
16th frame.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSe:DIVider <Divider>

The command sets the divider for the pulsed marker signal in the setting
SOURce:BB:GSM:TRIGger:OUTPut:MODE PULSe. The pulse frequency is derived by
dividing the symbol rate by the divider.

Parameters:
<Divider> integer

Range: 2  to  2^10
Increment: 1
*RST: 2

Example: BB:GSM:TRIG:OUTP2:PULS:DIV 2
sets the divider for the marker signal on output MARKER 2 to the
value 2.
BB:GSM:TRIG:OUTP2:FREQ?
queries the resulting pulse frequency of the marker signal.
Response: 66 000
the resulting pulse frequency is 66 kHz.

[:SOURce<hw>]:BB:GSM:TRIGger:OUTPut<ch>:PULSe[:FREQuency]?

The command queries the pulse frequency of the pulsed marker signal in the setting
SOUR:BB:GSM:TRIG:OUTP:MODE PULS. The pulse frequency is derived by dividing
the symbol rate by the divider. The divider is defined with command
SOUR:BB:GSM:TRIG:OUTP:PULS:DIV.

Return values: 
<Frequency> float

Marker Settings
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Example: BB:GSM:TRIG:OUTP2:PULS:DIV 4
sets the divider for the marker signal on output MARKER 2 to the
value 4.
BB:GSM:TRIG:OUTP2:MODE PULS
enables the pulsed marker signal.
BB:GSM:TRIG:OUTP2:PULS:FREQ?
queries the resulting pulse frequency for the marker signal.
Response: 33 000
the resulting pulse frequency is 33 kHz.

Usage: Query only

4.7 Power Ramping/Slot Attenuation

[:​SOURce<hw>]: ​BB:​GSM:​PRAMp: ​BBONly[:​STATe]​............................................................94
[:​SOURce<hw>]: ​BB:​GSM:​PRAMp: ​FDELay ​.........................................................................94
[:​SOURce<hw>]: ​BB:​GSM:​PRAMp: ​RDELay ​........................................................................95
[:​SOURce<hw>]: ​BB:​GSM:​PRAMp: ​SHAPe ​..........................................................................95
[:​SOURce<hw>]: ​BB:​GSM:​PRAMp: ​TIME​.............................................................................95

[:SOURce<hw>]:BB:GSM:PRAMp:BBONly[:STATe] <State>

Note: This command is available for instruments with RF output only.

This command selects power ramping in the baseband only or mixed power ramping in
the baseband and the RF section. The "ON" setting is mandatory if, with power ramping
active, only the baseband signal is output (I/Q outputs), or, in case of two-path instru-
ments, if a baseband signal is applied to two RF paths (RF A and RF B).

Only then can a signal with a defined, predictable level be output.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:GSM:PRAM:BBON ON
selects power ramping in the baseband only.

[:SOURce<hw>]:BB:GSM:PRAMp:FDELay <FDelay>

The command sets the offset in the Falling edge of the ramp envelope at the end of a
slot. A positive value gives rise to a ramp delay and a negative value advances the ramp.
The setting is expressed in symbols.

Parameters:
<FDelay> float

Range: -9 Symbols  to  9 Symbols
Increment: 1 Symbol
*RST: 0 Symbols
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Example: BB:GSM:PRAM:FDEL -1
sets an advance of 1 symbol in the falling edge of the envelope at
the end of the slot.

[:SOURce<hw>]:BB:GSM:PRAMp:RDELay <RDelay>

The command sets the offset in the Rising edge of the ramp envelope at the start of a
slot. A positive value gives rise to a ramp delay and a negative value advances the ramp.
The setting is expressed in symbols.

Parameters:
<RDelay> float

Range: -9 Symbols  to  9 Symbols
Increment: 1 Symbol
*RST: 0 Symbols

Example: BB:GSM:PRAM:RDEL -1
sets an advance of 1 symbol in the rising edge of the envelope at
the start of the slot.

[:SOURce<hw>]:BB:GSM:PRAMp:SHAPe <Shape>

The command sets the edge shape of the ramp envelope.

Parameters:
<Shape> LINear | COSine

LINear
The transmitted power rises and falls linear fashion.
COSine
The transmitted power rises and falls in the shape of a cosine.
*RST: COSine

Example: BB:GSM:PRAM:SHAP LIN
sets a cosine-shaped rise and fall to the edge.

[:SOURce<hw>]:BB:GSM:PRAMp:TIME <Time>

The command sets the edge slope of the ramp envelope. This specifies the number of
symbols over which the switching operation should be stretched when the transmitted
power is turned on and off.

Parameters:
<Time> float

Range: 0.3 Symbols  to  16.0 Symbols
Increment: 0.1 Symbols
*RST: 5.0 Symbols

Example: BB:GSM:PRAM:TIME 6
sets the duration of the switching operation to 6 symbols.

Power Ramping/Slot Attenuation
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4.8 Burst Editor

FRAMe<di>
Value range [1]|2
SLOT<st0>
Value range 0|[1] .. 7
SUBChannel<us>
Value range [1]|2
Determines the VAMOS subchannel

USER<ch>
Value range [1]|2
Determines the user in a half rate mode

[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>:​TYPE​...................................................97
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

LEVel ​...................................................................................................................97
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

ATTenuation ​..........................................................................................................98
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

SCPIRatio ​.............................................................................................................98
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

FILTer:​TYPE​.........................................................................................................99
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​MULTislot<st0>: ​COUNt ​..........................................99
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>][:​

SOURce]:​DATA​...................................................................................................100
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>][:​

SOURce]:​DATA:​DLISt​..........................................................................................100
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>][:​

SOURce]:​DATA:​DLISt:​CATalog ​............................................................................101
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>][:​

SOURce]:​DATA:​PATTern​.....................................................................................101
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​MULTislot<st0>: ​STATe​.........................................101
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

SFLag ​.................................................................................................................102
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

SFLag: ​USE ​.........................................................................................................102
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>][:​

SOURce]:​TSC:​SELect ​..........................................................................................103
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>][:​

SOURce]:​TSC:​SET​..............................................................................................103
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>][:​

SOURce]:​TSC:​USER ​...........................................................................................103
[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​

ETSC​.................................................................................................................104
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[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
ETSC:​USER ​........................................................................................................104

[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
SYNC: ​SELect ​......................................................................................................104

[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
SYNC: ​USER ​.......................................................................................................105

[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
FCORrection: ​FIXed​..............................................................................................105

[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
FCORrection: ​FIXed:​PATTern​................................................................................105

[:​SOURce<hw>]: ​BB:​GSM[:​FRAMe<di>]: ​SLOT<st0>[:​SUBChannel<us>][: ​USER<ch>]: ​
DUMMy: ​MIXed:​PATTern​......................................................................................106

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>:TYPE <Type>

The command selects the burst (slot) type.

Parameters:
<Type> NORMal | HALF | EDGE | SYNC | FCORrection | DUMMy |

ACCess | ADATa | AEDGe | N16Qam | N32Qam | A16Qam |
A32Qam | HQPSk | H16Qam | H32Qam | HAQPsk | HA16Qam |
HA32Qam | NAFF | NAFH | NAHH | AAQPsk
N16Qam | N32Qam
Normal 16QAM | Normal 32QAM
HQPSk | H16Qam | H32Qam
HSR QPSK | HSR 16QAM | HSR 32QAM
NAFF | NAFH | NAHH
Normal AQPSK Full rate - Full rate | Normal AQPSK Full rate - Half
rate | Normal AQPSK Half rate - Half rate
Axxxxx (All Data)
The types All Data GSM (ADATa), All Data EDGE (AEDGe), All
Data AQPSK (AAQPSk), All Data 16QAM (A16Qam), All Data
32QAM (A32Qam), HSR All Data QPSK (HAQPsk), HSR All Data
16QAM (HA16Qam) and HSR All Data 32QAM (HA32Qam) are not
defined in the standard.
*RST: NORMal

Example: BB:GSM:SLOT:TYPE DUMM
selects DUMMY burst type for slot 1.

Options: Higher Symbol Rate Mode, higher order modulation schemes
(16QAM and 32QAM) and AQPSK modulation are available for
instruments equipped with option R&S SMx/AMU-K41 only.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:LEVel <Level>

The command defines the power control level of the selected slot.
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Parameters:
<Level> OFF | ATT | FULL

OFF
The slot is inactive.
ATT
The power is reduced by the amount defined
using :BB:GSM:SLOT:ATT.

FULL
Full power as specified by the level setting.
*RST: Slot 0: FULL; Slots 1...7: OFF

Example: BB:GSM:SLOT2:LEV FULL
selects power control level Full Power for slot 2.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ATTenuation <Attenuation>

The command selects one of seven possible values for the level attenuation. This value
defines by how much the power of the selected slot with power control
level :BB:GSM:SLOT:LEV ATT will be reduced in relation to the normal output power
(attribute ...:LEVEL FULL). The seven possible values are set using the com-
mand :SOURce:BB:GSM:SATTenuation<n>.

Parameters:
<Attenuation> A1 | A2 | A3 | A4 | A5 | A6 | A7

Example: BB:GSM:MODE SING
selects GSM mode Frame (Single).
BB:GSM:SLOT1:LEV ATT
sets level attenuation mode for slot 1.
BB:GSM:SATT1 12dB
sets the level attenuation for selection A1 to 12 dB.
BB:GSM:SLOT1:ATT A1
sets the level attenuation for slot 0 to 12 dB.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SCPIRatio <SCPIRatio>

The command selects one of eight possible values for the SCPIR. The eight possible
values are set using the command ​[: ​SOURce<hw>]: ​BB: ​GSM: ​AQPSk: ​SCPIR<ch0> ​.

Parameters:
<SCPIRatio> SCPIR7 | SCPIR6 | SCPIR5 | SCPIR4 | SCPIR3 | SCPIR2 |

SCPIR1 | SCPIR0
*RST: SCPIR0

Example: BB:GSM:AQPS:SCPIR5 -10
BB:GSM:SLOT:SUBC2:SCPIR SCPIR5

Burst Editor
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:FILTer:TYPE <Type>

(for Higher Symbol Rate slots and instruments equipped with K41 only)

Selects whether a Narrow Pulse Shape or a Wide Pulse Shape filter should be use for
the selected burst type and modulation.

Parameters:
<Type> ENPShape | EWPShape

*RST: ENPShape

Example: BB:GSM:SRAT:MODE HSR
selects higher symbol rate mode.
BB:GSM:FRAM1:SLOT1:TYPE H16Q
selects HSR 16QAM burst type for slot 1.
BB:GSM:FRAM1:SLOT1:FILT:TYPE EWPS
selects Wide Pulse Shape filter for slot 1.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTislot<st0>:COUNt <Count>

The command defines the number of slots combined in a multislot. Since multislot
involves connecting multiple slots to a single user channel, this configuration is possible
for Normal (Full Rate) bursts Normal (8PSK / EDGE) burst
(SOUR:BB:GSM:FRAM:SLOT:TYPE NORM|EDGE) and EDGE Evolution bursts.

The suffix in MULTislot defines the first slot in a multislot group. In a multiframe con-
figuration this setting applies to the slots in all frames.

Parameters:
<Count> integer

Range: 1  to  8
*RST: 1

Example: BB:GSM:MODE SING
selects GSM mode Frame (Single).
BB:GSM:SLOT0:TYPE NORM
selects the NORMal burst type for slot 0.
... SLOT1 ... SLOT7
selects burst type for slots 1 to 7 correspondingly.
BB:GSM:MULT0:COUN 8
defines a multislot from all 8 slots.
BB:GSM:MULT0:STAT ON
switches the multislot configuration on.
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:DATA <Data>

The command defines the data source for the DATA fields in the burst. This command
is valid only when burst types that contain data fields are selected. If a burst contains
multiple DATA fields, these are treated as a continuous field, and for instance data such
as a pseudo-random sequence is continued without interruption from one DATA field to
the next.

In "GSM Mode Unframed", this command defines the data source for the unframed signal.
The suffix in :SLOT has to be set to 0 (BB:GSM:SLOT0:DATA).

Parameters:
<Data> ALL0 | ALL1 | PATTern | PN9 | PN11 | PN15 | PN16 | PN20 | PN21 |

PN23 | DLISt
PNxx
The pseudo-random sequence generator is used as the data
source. There is a choice of different lengths of random sequence.
DLISt
A data list is used. The data list is selected with the aid of command
SOURce:BB:GSM:SLOT:DATA:DLISt.

ALL0 | ALL1
Internal 0 or 1 data is used.
PATTern
Internal data is used. The bit pattern for the data is defined with
the aid of command :SOURce:BB:GSM:SLOT:DATA:PATTern.

*RST: PN9

Example: BB:GSM:SLOT2:TYPE NORM
selects NORMAL burst type for slot 2.
BB:GSM:SLOT2:DATA PN15
selects internal PRBS data with period length 215-1 as the data
source for the DATA fields in the burst. The pseudo-random
sequence is continued without interruption from one DATA field to
the next.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:DATA:DLISt <DList>

The command selects a data list. This command is only valid for bursts with DATA fields.
This data list is only used if it is set as the data source with the aid of com-
mand :BB:GSM:SLOT:DATA DLIS.

Parameters:
<DList> string

Burst Editor



Remote-Control CommandsGSM/EDGE

101Operating Manual 1171.5254.12 ─ 12

Example: BB:GSM:SLOT2:TYPE NORM
selects NORMAL burst type for slot 2.
BB:GSM:SLOT2:DATA DLIS
selects internal data lists as the data source for DATA fields.
BB:GSM:SLOT2:DATA:DLIS 'test'
selects the test data list. The data list is continued without inter-
ruption from one DATA field to the next.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:DATA:DLISt:CATalog?

This command reads out the data list files in the default directory. The default directory
is set using command MMEM:CDIRectory. Only files with the file extension *.dm_iqd
will be listed.

Return values: 
<Catalog> string

Example: MMEM:CDIR '<root>\user\dlist_gsm
sets the default directory to <root>\user\dlist_gsm.
BB:GSM:SLOT2:DATA:DLIS:CAT?
queries the available data lists in <root>\user\dlist_gsm.
Response: 'test_01','test_02'
data lists test_01 and test_02 are available in <root>\user
\dlist_gsm.

Usage: Query only

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:DATA:PATTern <Pattern>

The command selects the data pattern for the internal data when PATTern is selected
as the data source. The length depends on the length of the data fields in the selected
burst type.

Parameters:
<Pattern> integer

Example: BB:GSM:SLOT2:TYPE ACC
selects the Access burst type for slot 2. This burst type contains a
36-bit data field.
BB:GSM:SLOT2:DATA PATT
selects Pattern as the data source.
BB:GSM:SLOT2:DATA:PATT #H801FA,20
generates the data for the data field in the burst.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:MULTislot<st0>:STATe <State>

The command switches the multislot configuration on.
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The suffix in MULTislot defines the first slot in a multislot group. In a multiframe config-
uration this setting applies to the slots in all frames.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: OFF

Example: BB:GSM:MODE DOUB
selects GSM mode Frame (Double).
BB:GSM:SLOT0:TYPE NORM
selects the NORMal burst type for slot 0.
... SLOT1 ... SLOT7
selects burst type for slots 1 to 7 correspondingly.
BB:GSM:MULT0:COUN 8
defines a multislot from all 8 slots.
BB:GSM:MULT0:STAT ON
switches the multislot configuration on.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SFLag <SFlag>

The command sets the Stealing Flag state (only for Normal burst :BB:GSM:SLOT:TYPE
NORM).

Parameters:
<SFlag> 0 | 1

*RST: 0

Example: BB:GSM:SLOT2:TYPE NORM
selects NORMAL burst type for slot 2.
BB:GSM:SLOT2:SFL 1
sets Stealing Flags for slot 2 to the value 1.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SFLag:USE <Use>

The command enables or disables the use of Stealing Flags. If not used, the Stealing
Flags bits are allocated to the DATA fields (only for Normal burst :BB:GSM:SLOT:TYPE
NORM).

Parameters:
<Use> 0 | 1 | OFF | ON

*RST: ON

Example: BB:GSM:SLOT2:TYPE NORM
selects NORMAL burst type for slot 2.
BB:GSM:SLOT2:SFL 1
sets Stealing Flags for slot 2 to the value 1.
BB:GSM:SLOT2:SFL:USE ON
enables the use of Stealing Flags for slot 2.
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:TSC:SELect <Select>

The command selects the training sequence code. The values specified in GSM 5.02 are
T0...T7. When USER is selected, the value specified with the aid of
the ...:TSC:USER command described next is used.

Parameters:
<Select> T0 | T1 | T2 | T3 | T4 | T5 | T6 | T7 | USER

*RST: T0

Example: BB:GSM:MODE SING
selects Single Frame mode.
BB:GSM:SLOT2:TYPE NORM
selects Normal burst for slot 2.
BB:GSM:SLOT2:TSC:SEL T3
selects training sequence code T3 for slot 2.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:TSC:SET <Set>

Sets the TSC set for the corresponding GMSK normal burst or VAMOS subchannel, user
and slot.

Parameters:
<Set> SET1 | SET2

*RST: SET1

Example: BB:GSM:SLOT2:SUBC2:USER2:TSC:SET SET2

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>][:SOURce]:TSC:USER <User>

The command specifies the user-defined training sequence code. This code is used if
the USER parameter is set with the aid of the ​[: ​SOURce<hw>]: ​BB: ​GSM[: ​
FRAMe<di>]: ​SLOT<st0>[: ​SUBChannel<us>][: ​USER<ch>][: ​SOURce]: ​TSC: ​
SELect ​ command. The length is 26 bits for :BB:GSM:SLOT:TYPE NORMal and 78 bits
for :BB:GSM:SLOT:TYPE EDGE.

Parameters:
<User> integer

Range: #B0,1  to  #B111 ,1...26/78 bits
*RST: #H0970897

Example: BB:GSM:SLOT3:TSC:USER #H3FFFFFF
enters the user-defined training sequence for slot 3.
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ETSC <Etsc>

The command selects an extended training sequence for the Synchronization burst.
There is a choice of three predefined sequences STANdard | CTS | COMPact and,
if defined, a USER sequence (only for selection of burst type :BB:GSM:SLOT:TYPE
SYNC).

Parameters:
<Etsc> STANdard | CTS | COMPact | USER

Example: BB:GSM:SLOT:TYPE SYNC
selects Synchronization burst for slot 1.
BB:GSM:SLOT:ETSC CTS
selects the extended training sequence CTS.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:ETSC:USER <User>

(only for selection of burst type :BB:GSM:SLOT:TYPE SYNC)

The command selects an extended training sequence for the Synchronization burst
USER sequence.

Parameters:
<User> integer

Example: BB:GSM:SLOT:TYPE SYNC
selects Synchronization burst for slot 1.
BB:GSM:SLOT:ETSC USER
selects the extended training sequence User.
BB:GSM:SLOT:ETSC:USER #H5a5a5a5a5a5a5a5a,64
sets the ETSC.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SYNC:SELect <Select>

The command selects a training sequence (SYNC sequence) for the Access burst (only
for burst type selection :BB:GSM:SLOT:TYPE ACC).

Parameters:
<Select> T0 | T1 | T2 | USER

*RST: T0

Example: BB:GSM:SLOT1:TYPE ACC
selects Access burst for slot 1.
BB:GSM:SLOT1:SYNC:SEL T1
selects Sync sequence T1.
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[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:SYNC:USER <User>

The command outputs the bit pattern of the User Sync sequence for the Access burst.
The length is 64 bits. Superfluous bits are truncated on input. Missing bits are filled with
0. The command is valid only for selection :BB:GSM:SLOT:SYNC:SEL USER and for
burst type selection :BB:GSM:SLOT:TYPE ACC.

Parameters:
<User> integer

Range: #B0,1  to  #B111...,41
*RST: Bit pattern from T0

Example: BB:GSM:SLOT1:TYPE ACC
selects Access burst for slot 1.
BB:GSM:SLOT1:SYNC:SEL USER
selects the User Sync sequence.
BB:GSM:SLOT1:SYNC:USER #HFFFFFFFFFF0,41
enters the User Sync sequence.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:FCORrection:FIXed <Fixed>

The command selects the content of the FIXED field for the Frequency Correction burst.
There is a choice of two predefined sequences STANdard and COMPact and, if defined,
a USER sequence (only for burst type selection :BB:GSM:SLOT:TYPE FCORrection).

Parameters:
<Fixed> STANdard | COMPact | USER

*RST: STANdard

Example: BB:GSM:SLOT:TYPE FCOR
selects Frequency Correction burst for slot 1.
BB:GSM:SLOT:FCOR:FIX COMP
selects content type COMPact for the Fixed field.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:FCORrection:FIXed:PATTern <Pattern>

The command enters the bit pattern of the FIXED field for the Frequency Correction burst.
The length is 142 bits. Superfluous bits are truncated on input. Missing bits are filled with
0. The command is valid only for the selection :BB:GSM:SLOT:FCOR:FIX USER and
for burst type selection :BB:GSM:SLOT:TYPE FCOR.

Parameters:
<Pattern> integer

Range: #B000...0,142  to  #B111...1,142
*RST: Bit pattern from the STANdard
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Example: BB:GSM:SLOT:TYPE FCOR
selects Synchronization burst for slot 1.
BB:GSM:SLOT:FCOR:FIX USER
selects content type USER for the Fixed field.
BB:GSM:SLOT:FCOR:FIX:PATT  #B0,142
enters the content of the field.

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:SUBChannel<us>][:
USER<ch>]:DUMMy:MIXed:PATTern?

This command outputs the bit pattern of the Mixed field of the Dummy burst. The contents
of the Mixed field is fixed and specified by the standard, the length is 142 bits.

Return values: 
<Pattern> integer

Example: BB:GSM:SLOT1:TYPE DUMM
selects Dummy burst for slot 1.
BB:GSM:SLOT1:DUMM:MIX:PATT?
outputs the bit pattern of the Mixed field.
Response:

Usage: Query only

4.9 Slot Marker Definition

[:SOURce<hw>]:BB:GSM[:FRAMe<di>]:SLOT<st0>[:USER<ch>]:TRIGger:
OUTPut:TAG?

The command queries the content of the specified marker in the selected file.

Suffix: 
<di>

.
<di>

<st0> 0|[1] .. 7

<ch> <di>

Parameters:
<Tag> string

Example: BB:GSM:FRAM:SLOT0:UER1:TRIG:OUTP:TAG? "MARKER
LIST 1"
queries the content of the marker list 1.
Response: 0:1;59:0;64:1,70:0

Usage: Query only
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